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Introduction

NCS

ARP

A Telnet for the Macintosh provides interactive access from a Macintosh com-
puter to telnet hosts on TCP/IP networks. NCSA Telnet is an implementation of

A standard telnet. You can have simultaneous connections to numerous com-
puters across the network, and a standard file transfer server (FTP) lets you trans-

fer files to and from remote machines and other users.

This introduction presents an overview of the capabilities and features of Version
2.6 of NCSA Telnet for the Macintosh. Notational conventions used in this manual

are also explained.

Features of NCSA Telnet

Special features of NCSA Telnet include:

VT102/VT220 emulation

FTP client

File transfer server (standard FTP)

Simultaneous telnet connections to a number of computers
Tektronix 4014 and 4105 emulation

Color raster graphics capabilities

Domain name lookup using MacTCP

Scrollback with ability to print and copy

User-defined macro keys

Customized window arrangement facility

Support for window contents of fewer or greater than 24 lines
Support for any font, font size, or color

Line-mode support (RFC 1184)

Encrypted and authenticated telnet sessions

Differences hetween Version 2.5 and Version 2.6

New Features in Versi

on 2.6

Encrypted sessions

Authenticated sessions

Cornell Kerberos driver

Translation Tables

Graphical configuration

PAGE UP, PAGE DOWN, HOME, and END keys
EMACS mode for arrow keys

MacBinary II

Resizeable TEK windows

VT printing escape sequence



CDUP command for FTP server

Optional inhibition of TEK emulation

Two paste modes, quick and block

Directly specified answerback message

Integrated Telpass functionality

Default transfer directory for each FTP user

Optional FTP ISO translation

User modification of default file type and creator type for binary files
User modification of creator type for text files

Xterm change window title sequence from remote host
User modification of window title

Error message system

Discontinued Features

The most important difference between Version 2.5 and Verion 2.6 is the removal
of all external configuration files. All parameters of NCSA Telnet Version 2.6 can
and must be configured from within the application. Although the config. tel file
is no longer required, we recommend that you retain a copy in case you have to use
an older version of NCSA Telnet.

Version 2.6 maintains all of its configuration in the NCSA Telnet Preferences file,
which is stored in the Preferences folder of your System folder. You cannot edit
the format of this file.

These other Version 2.5 features are no longer available in Version 2.6:

Serial Connections
SLIP Connections via built-in drivers
NCSA TCP/IP drivers

Bugs Fixed from Version 2.5
Many of the bugs present in Version 2.5 have been corrected in Version 2.6. The
bugs and problems that have been fixed include:
Next Session no longer redraws windows unnecessarily.

Dropped connections no longer ignore the Windows don’t go away option in the
Global Preferences dialog box.

Several memory leaks have been plugged.

System Requirements

To run Version 2.6, you need a Macintosh running Version 6.0 or later system soft-
ware and MacTCP. You also need an IP address assigned to your Macintosh.

Notational Conventions

Before using NCSA Telnet for the Macintosh, you should know how to use the
mouse, issue commands from menus, work with windows, and locate files using
directory dialog boxes. If you are unfamiliar with the Macintosh user interface or
need more detailed information regarding these procedures, please refer to your
Macintosh user’s guide.
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Material in this manual is presented in text, screen displays, or command-line nota-
tion. Different typefaces indicate different functions.

New concepts or terms are generally in italic type when they first occur in text,
which indicates that they are defined in the paragraph.

Cross references usually include the title of the referenced section or chapter
enclosed in quotation marks (e.g., see Chapter 1, “Getting Started”) and the
number of the page on which the section begins.

Boldface type represents characters you enter as shown (literal expressions).
Lowercase italic type represents a variable, a placeholder for the text you actu-
ally enter. A variable can consist of different characters each time you make
the entry.

You may be instructed to enter specific characters on the keyboard. These
entry instructions (command lines) are printed in nonproportional (mono-
spaced) boldface type (e.g., dothis) and appear either within a paragraph or on
a separate line. Command lines are normally entered in lowercase type.
Monospace type that is not boldbace (e.g., the 1ist command) indicates UNIX
commands and options, filenames, directory and folder names, and machine
addresses and names.

Helvetica boldface type (e.g., the Cancel button) represents boxes and buttons
(options) in dialog boxes, commands on pull-down menus, menu names, and
window and dialog box names.

Keys that are labeled on your keyboard with more than one character, such as
the RETURN key, are identified by all-uppercase letters in normal font.

Keys that you are to press simultaneously or in succession are linked with a
hyphen (e.g., press SHIFT-OPTION-D).

A check mark (v/) appears in a pull-down menu when a command is selected,
as is standard in software for Macintosh computers.
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NCSA Telnet for the Macintosh Version 2.6 source code and documentation are in the public

domain. Specifically, we give to the public domain all rights for future licensing of the source
code, all resale rights, and all publishing rights.

We ask, but do not require, that the following message be included in all derived works: Por-
tions developed at the National Center for Supercomputing Applications at the University of Illi-
nois at Urbana-Champaign.

READ ME NOW

If you want to see more software like NCSA Telnet, please contact us by email or U.S. malil,
telling us what you are doing with NCSA Telnet. We need to know: (1) What science you are
working on—an abstract of your work would be fine; and (2) How NCSA Telnet has helped
you, for example, by increasing your productivity or allowing you to do things you could not
do before.

We encourage you to cite the use of NCSA Telnet, and any other NCSA software you have
used, in your publications. A bibliography of your work would be extremely helpful.

Disclaimer

The University of Illinois gives no warranty, express or implied, for the software and/or docu-
mentation provided, including, without limitation, warranty of merchantibility and warranty
of fitness for a particular purpose.

Acknowledgment

A great deal of thanks goes to Rick Watson of the University of Texas for help ing incorporate
his authentication and encryption code into NCSA Telnet and for his permission to use parts
of his documentation for this manual. See “Authentication and Encryption” on page 3-5.

Trademarks

AppleTalk, LaserWriter, Mac, Apple, and Macintosh are registered trademarks and Macintosh
Plus is a trademark of Apple Computer Inc. / UNICOS is a registered trademark of Cray
Research Inc. / VT, VT100, VT102, and DEC are registered trademarks and VT220, VAX, and
VMS are trademarks of Digital Equipment Corporation / Helvetica is a registered trademark
of Linotype Company / Microsoft Word is a registered trademark of Microsoft Corporation /
Sun is a registered trademark of Sun Microsystems Inc. / Tektronix 4014 and Tektronix 4105
are trademarks of Tektronic Inc. / UNIX is a registered trademark of X/Open

NCSA Contacts
Mail user feedback, bug reports, questions, and software and manual suggestions to:

Software Development Group
NCSA Telnet
152 Computing Applications Bldg.
605 E. Springfield Ave.
Champaign, IL 61820-5518
Send electronic mail to one of the following:
About NCSA Telnet: mactelnet@ncsa.uiuc.edu

About other SDG products: softdev@ncsa.uiuc.edu

Orders
All NCSA products are available without charge from NCSA’s anonymous FTP server:
ftp ftp.ncsa.uiuc.edu
Hardcopy manuals and software disks and tapes can be ordered through the NCSA Technical
Resources Catalog. All orders must be prepaid. For a copy of the catalog, contact NCSA Orders
by email at orders@ncsa.uiuc.edu, by phone at (217) 244-4130, or by U.S. mail at:

NCSA Orders

152 Computing Applications Bldg.

605 E. Springfield Ave.

Champaign, IL 61820-5518



Getting Started

This chapter introduces the basic steps involved in using NCSA Telnet for the Mac-
intosh Version 2.6:

beginning an NCSA Telnet session

opening and closing a connection

copying, pasting, and printing the contents of session windows

ending an NCSA Telnet session
It is assumed that you already know how to click and drag using the mouse, how to
move and resize windows, and how to select items from menus. If you are unfamil-

iar with the Macintosh user interface or need additional information regarding
these procedures, please refer to your Macintosh user’s guide.

Installation Note

This chapter assumes that your system or network administrator has already
installed NCSA Telnet on your system, assigned an IP address to your Macintosh,
and given you a login name and password for the computer to which you want to
connect. For information regarding installation and customization procedures, see
the second chapter (“Configuration” on page 2-1).

Beginning an NCSA Telnet Session

Invoke NCSA Telnet by double-clicking on the NCSA Telnet file or application icon.
The NCSA Telnet application icon is shown below:

[EHEHE]
Telnetz &

A box introducing NCSA Telnet appears on your screen, then disappears.



Opening and Closing a Connection

Opening a Connection

To open a connection to a host:

1.

Select Open Connection... from the File menu, which displays the Open Connection
dialog box:

Open Connection... 3#0
Open Special [ 2
Close I
Load Set... [ 2
Save Set...

MacBinary 11 Enabled

Show FTP Log

Print Selection... #P
Page Setup...
Quit 30

Fill out the Open Connection dialog box. In the Host/Session Name box, enter the
name of the host to which you want to connect. The session name can be any
hostname, IP address, or alias. You may optionally append an alternate port
number to connect to after the hostname, IP address, or alias. In the sample
Open Connection dialog box below, the hostname is pluto:

Host/Session
Mame

Window Name | |

=]

|p|utu

C]FTP session [3F)
] Authenticate (#A)
O] £serynt =i}

In the Window Name box, enter any name you wish for the connection’s window.
This optional feature is not necessary with single connections but is very use-

ful when you open multiple connections. If you do not specify a window name,
the connection’s window title is set to the contents of the Host/Session Name box
and a number is appended.

If you want to connect as an FTP client, check the FTP Session box. For more
information, see “Using an FTP Client” on page 4-2.

If you want to start an authenticated or encrypted connection, check the
Authenticate box. Authenticate must be checked if you wish to use encryption. For
more information, see “Authentication and Encryption” on page 3-5.

Click the Connect button, or press the RETURN key on your keyboard.
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NCSA Telnet attempts to connect to the host you specify, a process that generally
takes only a few seconds. When a connection is established, a Connection window
appears. The Window Name you specify in the Open Connection dialog box appears
both in the title bar of the Connection window and in the Connections menu.

See the second chapter (“Configuration” on page 2-1) for alternative ways to open a
connection, for session names other than the hostname, and for a discussion of
aliases. For information about working with multiple sessions, see “Multiple Con-
nections” on page 3-1.

Logying on to Your Host

The Connection window indicates the name and type of your host machine and
prompts you to enter your login name. For example, if you attempt to connect to a
Sun system named pTuto, the login prompt may look like this:

Sun0S UNIX (pluto)
login:

To log on:

1. Enter your login name at the login prompt and press RETURN. The host
prompts you to enter your password.

2. Enter your password and press RETURN.

Now that you are logged on and running NCSA Telnet, your Macintosh operates as
a VT102 or VT220 terminal that is remotely connected to the host.

NOTE: The response time of a host can vary. If the remote host is heavily loaded, a
few minutes may elapse after the connection opens before the host prompts you to
log on.

Setting the BACKSPACE/DELETE Key

NCSA Telnet automatically translates BACKSPACE/DELETE keypresses into delete
codes. This makes NCSA Telnet compatible with systems that prefer delete to back-
space. If your backspaces are not accepted, the host you are using may accept only
backspace codes.

To test this possibility, select Backspace from the Session menu, which changes the
setting of the BACKSPACE/DELETE key to backspace. This resets the default trans-
lation so that the key sends a backspace code. If your backspaces are now accepted,
the host prefers backspace codes.

Change the setting of the BACKSPACE/DELETE key by selecting the desired key-
code (Backspace or Delete) from the Session menu. For more information regarding
the configuration of the BACKSPACE/DELETE key, see “Editing Session Configura-
tion Records” on page 2-5.

Setting a VT Terminal Type

NCSA Telnet can emulate either a VIT102 or a VT220 terminal. When you log on to a
host, the host operating system does not always know what type of terminal you
are using. For instructions on setting terminal type, consult the operating system
manual for your host.

Try setting the terminal type to VT100 or VT102. Many UNIX and some other system
do not support VT102. For such systems, set terminal type to VT100 or tab132
(which is compatible with VT102 emulators).

The following examples demonstrate how to set the terminal type for two popular
operating systems and hosts, UNIX (using the C shell) and VAX/VMS.
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For UNIX using a C shell and VT100 terminal type: % set term=vtl00;tset

For UNIX using a C shell and VT220 terminal type: % set term=vt220;tset

For VAX/VMS:

B$ set term /inq

Emulating the VT Terminal Keyhoard

Many keys are the same on both the Macintosh and VT keyboards. These key-
strokes are transmitted by NCSA Telnet without modification. However, the VT
keyboard has some keys that the Macintosh keyboard does not have and also treats
or labels other keys differently. In addition, many VT keys have special meanings
when they are transferred to the host.

You can use the Macintosh keyboard to provide full VI220 functionality. Note that
the position of the Macintosh numeric keypad is identical to that of the VT keypad,
although the labels are different. If you are accustomed to using a VT keypad, you
can ignore the Macintosh labels and enter as usual on the VT keypad.

Macintosh key commands that correspond to key commands on a VT terminal are
listed below.

VT Keyboard Macintosh Plus Keyboard Apple Desktop Bus Keyboard
(backquote) 8- or OPTION- =* ¥-" or OPTION-" =

ESC’ : ESC or °

DELETE? BACKSPACE DELETE or DEL

BACKSPACE* OPTION-BACKSPACE OPTION-DELETE

LINE FEED CONTROL-1J CONTROL-1J

PF1 CLEAR on keypad CLEAR on keypad

PF2 / on keypad / on keypad

PF3 = on keypad = on keypad

PF4 * on keypad * on keypad

CONTROL-SPACEBAR(NUL) OPTION-SPACEBAR CONTROL-SPACEBAR

Keypad keys Keypad keys Keypad keys

* You must use 38-" if the Remap backquote to ESCape option is on.

" Use of * as ESC is governed by how you set the Remap backquote to ESCape option in
the Global Preferences dialog box.

t See the BACKSPACE/DELETE key discussion in the section above.

For more information regarding NCSA Telnet’s emulation of VT terminals, see
Appendix B (“VT Emulation” on page B-1) and Chapter 2 (“Configuration” on
page 2-1). Appendix B also contains information about the mapping of VI220
function keys.

Closing a Connection

To close a connection to your host, use the logout procedure specific to that
system. On a UNIX system, for example, enter the UNIX Togout command at the
command-line prompt:

% Togout
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If you cannot log out in this manner, select Close from the File menu. A Close Connec-
tion dialog box appears on the screen to confirm that you want to forcibly close the
connection:

Are you certain you want to close the connection to
pluto?

Click on the OK button, or press the RETURN key.

After you log out, the Close Connection window disappears. You can now safely quit
the NCSA Telnet application.

Copying, Pasting, and Printing

NCSA Telnet lets you copy, paste, and print the contents of your session windows.

Copy and Paste from the Edit Menu
First select (highlight) text in the window.

To copy highlighted text of a window as is, choose Copy from the Edit menu.

To copy highlighted text of a window as a table, choose Copy Table from the Edit
menu. White spaces in the highlighted text are replaced by tabs, according to the
setting of the Copy Table threshold in the Global Preferences dialog box. You can paste
the table into a word-processing program such as Microsoft Word or into a spread-
sheet program such as Microsoft Excel.

To paste the clipboard contents into a session window, choose Paste from the Edit
menu.

NOTE: Copying and pasting are also discussed in Chapter 5, "Tektronix 4014 and
4105 Emulation," and Chapter 6, "Interactive Color Raster Graphics." The Copy Table
Threshold settings are discussed in the "Global Preferences" section of Chapter 2,
"Configuration.”

Print from the File Menu
First highlight the text you want to print.

To print highlighted text:
1. Choose Page Setup from the File menu, which opens the Page Setup dialog box.

2. In the Page Setup dialog box, specify the desired printing parameters, then click
the OK button or press the RETURN key.

3. Choose Print Selection from the File menu.

4. In the Print dialog box, specify the number of copies, printer, feed, and other
parameters. Then click the OK button or press the RETURN key.

For more information regarding the Page Setup and Print dialog boxes, refer to your
Macintosh user’s guide.

Getting Started [ 1-5



Ending an NCSA Telnet Session
To exit NCSA Telnet, select Quit from the File menu.

NOTE: You can quit NCSA Telnet any time during the program’s execution. How-
ever, you should, whenever possible, close connections to each system before quit-
ting NCSA Telnet to avoid loss of data or other complications. When you attempt to
quit NCSA Telnet before closing current connections, a Close Connection dialog box
appears to confirm that you want to forcibly close the connections. If you do, click
the OK button or press the RETURN key; if you do not want to forcibly close connec-
tions, click the Cancel button.
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2 Configuration

NCSA Telnet for the Macintosh allows you to customize the environment to suit
special needs and habits. Version 2.6 of NCSA Telnet for the Macintosh uses an
entirely new configuration system. This chapter describes global preferences you
can set, the new configuration system, saved sets, and macro definitions.

For information about configuring file-transfer services, see “Configuring an FTP
Server” on page 4-3.

Glohal Preferences

Several preference options affect every session or the operation of NCSA Telnet in
general. You can set these options to best suit your environment and work habits.

To set your global preferences, select Preferences » Global from the Edit menu. The
Global Preferences dialog box appears:

E Cornrnand Keys
|:| Rernap backquote to ESCape

Copy Table threshold [ Btink Cursar
Tirneslice @ Elock:

|:| windows don't go away
(<] staggered Wwindows () Wertical Bar

Capture File Ereat-:-r|tt><t |[ Select Application ]

D UndetTine

Each option in this dialog box is described below.

Option

Command Keys

Remap backquote to ESCape

Description

When you check this box, the menus are configured to accept com-
mand key equivalents.

NOTE: If the Command Keys box is not checked and if NCSA Telnet is
running on a Macintosh that has no CONTROL key, the 88 key remaps
to the CONTROL key. If the Command Keys box is checked on such
machines, you cannot generate CONTROL key characters.

When you check this box, NCSA Telnet sends the ESCape character to
the remote host when you press the grave accent (*). (This key is some-
times called the backquote.) This setting is helpful if you use an origi-
nal Macintosh or Macintosh Plus keyboard.

This option, however, is available no matter which type of keyboard
you have. Pressing 8- always produces a grave accent, regardless of
whether you check Remap backquote to ESCape in the Global Preferences
dialog box.



Copy Table threshold

Timeslice

Windows don’t go away

Staggered Windows

Blink Cursor

Block, Underline, Vertical Bar

Capture File Creator

The number you enter in this box determines the minimum number of
spaces that are replaced by tabs when you use the copy table com-
mand instead of the standard copy command. You can select Copy
Table from the Edit menu (or press 88-T) to copy a table from the NCSA
Telnet screen onto the clipboard.

When you select Copy Table from the Edit menu, all strings of contiguous
spaces greater than the threshold are turned into tabs before being
placed on the clipboard. This produces a format you can paste into
most spreadsheet and graphing programs without losing data or doing
additional formatting.

The number you enter in this box determines how much time NCSA
Telnet gives to other applications that may be running. Increasing this
number reduces NCSA Telnet’s responsiveness but improves the per-
formance of applications running in the background. The number you
enter is measured in sixtieths of a second.

When you check this box, session windows remain open after their
associated connections have terminated. The window title is placed in
parentheses to signify that the associated connection has closed. You
can view, copy, and print text in a window whose connection has been
closed. You can also read connection error messages from hosts that—
due to an error—may close connections immediately after they are
established.

To close such a window, either click in the window’s close box or select
Close from the File menu.

When you check this box, multiple windows are staggered by a whole
title bar. This lets you see each window’s title. If this box is not
checked, each new window is staggered by only a few pixels.

When you check this box, NCSA Telnet makes the cursor blink periodi-
cally in session windows.

You can choose the appearance of the cursor in session windows by
clicking the appropriate button: Block, Underline, or Vertical Bar.

Enter an appropriate four-letter creator type in this box to specify the
creator type assigned to the files in which NCSA Telnet saves text cap-
tured from sessions. Every Macintosh file has a file type and a file cre-
ator type. The file type specifies the type of file (e.g., text, word
processing document, saved set). The file creator type tells the Finder
which application to launch when you double-click on a filename.

If you already know the four-letter creator type for the application you
want to specify, enter it in the Capture File Creator box. If you do not
know the four-letter creator type, click the Select Application button in
the Global Preferences dialog box. This opens a standard Open File dialog
box. Double-click on the name of the application whose creator type
you want to find. NCSA Telnet then enters the four-letter creator type
in the Capture File Creator box.
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New Configuration System in Version 2.6

Version 2.6 of NCSA Telnet for the Macintosh uses an entirely new configuration
system. Earlier versions required an external text file named config.tel, which
contained keywords that specified the user’s preferences. The configuration sys-
tem for Version 2.6 is entirely graphical and does not require any external user-
editable files.

Ideally, all configuration options for a connection would be combined into one
entity. However, due to the large number of options for each connection, NCSA Tel-
net connection options are divided into two parts: a terminal configuration record
and a session configuration record. The terminal configuration record contains the
options that pertain primarily to NCSA Telnet’s terminal emulation. The session
configuration record contains the remaining options.

Each session configuration record has a terminal configuration record associated
with it. You determine which terminal record is associated with a given session
record.

Default Configuration Records
Reasonable default terminal and session configuration records are set when you
launch NCSA Telnet for the first time. Although you can change the preferences in
these defaults, you cannot delete the default configuration records.

The default terminal configuration record and default session configuration record
are used when you enter a hostname in an Open Connection dialog box. The prefer-
ences contained in the default configuration records are used as the defaults for
any connection that does not have a preconfigured session or terminal record. The
default records are also used to set the initial values of any new terminal or session
configuration records you may define.

Editing Gonfiguration Records

When you select either Preferences P Terminal or Preferences » Session from the Edit
menu, a Preferences dialog box appears similar to this one:

<Default: B
Ernazz Terrninal

Owen’s Terminal fhangs
Special Answerback Terrninal -

Bennuy

=

To add a new terminal or session configuration record, click the New button. To
change an existing terminal or session record, click the Change button. To remove
an existing terminal or session record, click the Remove button. You cannot remove
the default.
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Editing Terminal Configuration Records

Option

Terminal Name

Xterm sequences

Use VT wrap mode

EMACS arrow keys

When you click either New or Change in the Preferences dialog box, the Terminal Config-

uration Record dialog box appears:

Terrminal Marne | Owen’s Terminal |

E Aterm sequences
E Usze MT wrap mode
|:| EMACS arrow keys
E Map PgUp, etc.

|:| Eight bit connections
E Sawve cleared lines

Ernulation {3y wT100

Marrnal foreground
Maorrnal background
Elinking foreground

I
[ ]
[
[ 1]

Elinking background

I:‘ CNTL-COMMD is EMACS meta

i YTZ20

Screen Width Sores

Font [ Monaco I El Secrollback

Answerback Message |'-.-'T22III

|

Description

The terminal name you enter here is listed along with your other termi-
nal configuration records in the Terminal popup menu of the Session
Configuration Record dialog box.

When you edit the default terminal configuration record, the Terminal
Name field is hidden because you cannot rename the default record.

When you check this box, NCSA Telnet recognizes the Xterm escape
sequences for changing window and icon titles. NCSA Telnet changes
the title of the session’s window in response to those sequences.

When you check this box, NCSA Telnet sets the VT emulator to use
autowrap mode by default.

The VT terminal maintains an internal setting to determine whether
characters printed off the right-hand side of the screen cause the ter-
minal to wrap. If you set the terminal to wrap, new characters appear
on the next line of the screen and the screen scrolls as necessary. If
you disable wrap mode, each new character replaces the last character
on the current line and the cursor moves neither right nor onto the
next line.

NOTE: Any time you select Reset Terminal from the Session menu, wrap
mode is disabled.

When you check this box, pressing your keyboard’s arrow keys sends
the appropriate control codes for moving around in the EMACS editor.
When this box is not checked, NCSA Telnet sends the VT codes for the
arrow keys. This option also affects the codes sent when you you use
the optional mouseclick feature. For more information, see “Cursor
Positioning with the Mouse” on page 3-1.
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Map PgUp, etc.

Eight bit connections

Save cleared lines

CNTL-COMND is EMACS meta

Emulation

Font

Scrollback
Screen Width, Screen Height

Screen Colors

Answerback Message

When you check this box, NCSA Telnet uses the PAGE UP, PAGE DOWN,
HOME, and END keys to change position in the session’s scrollback
buffer (instead of sending the VT control codes for these keys to the
remote host).

When you check this box, NCSA Telnet does not strip out the eighth bit
from the data it receives. If you do not check this box, only the first
eight bits are retained and all other incoming data are stripped out.

When you check this box, any time a VT clear-screen code is received
NCSA Telnet saves the screen in the scrollback buffer before clearing
the screen. If you do not check this box, all data on the screen are lost.

When you check this box, pressing CONTROL-COMMAND-anykey is
equivalent to pressing META-anykey on a keyboard with a META key.
This option does not send META CONTROL keystrokes because the
CONTROL key is needed to activate such a sequence. In future ver-
sions of NCSA Telnet, this option will be changed to better simulate
META key sequences.

Selecting the VT100 or VT220 button activates VT100 or VT220 emula-
tion, respectively, for this connection.

Use the two boxes after Font to specify the font and font size used in
this connection.

In this box enter the number of lines you want in the scrollback buffer.
In these boxes enter the initial size of the VT emulation screen.

This option is visible only on color-equipped Macintosh computers.
Four boxes in the right-hand column (Normal foreground, Normal back-
ground, Blinking foreground, and Blinking background) let you set the fore-
ground and background colors for the normal and blinking text
modes. Clicking on any of the four boxes opens the standard Color
Wheel dialog box in which boxes are filled with the current color selec-
tion. For additional information on using the Color Wheel dialog box,
refer to the Macintosh System Software User’s Guide.

In this box specify the type of terminal you are using. NCSA Telnet
sends this text to a remote host that asks the terminal type being used.
The defaults are correct for almost all known systems.

Editing Session Configuration Records
Because the session configuration record is consulted only when NCSA Telnet ini-
tiates a connection, changes you make in the session configuration record affect
only new connections initiated after your change. Think of it as your favorite
cookie recipe: if you change the recipe today by adding nuts and chocolate chips,
the cookies you baked last week are not affected.

Configuration 0 25



Option

Alias

Hostname

Port

TEK

Paste Method

When you click either New or Change in the Preferences dialog box, the Session Configu-

ration Record dialog box appears:

Hostname |bnnham.zeppeh’n.cnm

TEK ) Inhibit ani4 w4105
Paste Method (@) Quick i) Elack
Delete Sends W Delete i) Backspace

|:| Forcesave
|:| Berkeley 4.3 CR rode

E<] anew tinemode Interrupt I:I
E TEK page clears screen

[ Hatt duplex Suzpend
|:| Show Tow lewel errors Pesume
|:| Authenticate

|:| Encrypt

|:| Local Echo

Termminal Translation Table

Description

In this box enter the name (alias) of the session configuration record.
Then, when you enter this alias in the Host/Session Name field of the
Open Connection dialog box, NCSA Telnet uses this session configura-
tion record as well as terminal configuration record specified in the
Terminal popup menu of the Session Configuration Record dialog box.

NOTE: Spaces are not allowed in alias names.

When you edit the default session configuration record, the Alias field
is disabled because you cannot rename default records.

In this box enter the name of the host to which you want to connect.
This text is passed to the MacTCP Domain Name Resolver (DNR), which
translates a host’s domain name into an IP address.

In this box enter the name of the port to which you want NCSA Telnet
to attempt the connection to the remote machine.

There are three choices for Tektronix emulation in NCSA Telnet. Inhibit
prevents NCSA Telnet from using any Tektronix emulation for this ses-
sion. 4014 and 4105 select Tektronix 4014 emulation or Tektronix 4105
emulation, respectively.

NCSA Telnet offers two different methods for pasting data into a ses-
sion. When you select the Quick button, NCSA Telnet sends all data to
be pasted to the remote host at one time. The Quick method works
well for small amounts of text and for sessions involving hosts that are
close to you on the network. When you select the Block button, NCSA
Telnet sends data to be pasted to the remote host in sections, or
blocks, of text. The size of the block is determined by the number you
enter in the box next to the Block button. Use the Block paste method
when you need to paste large amounts of text or when you are con-
nected to a machine that responds slowly.
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Delete Sends

Forcesave

Berkeley 4.3 CR Mode

Allow linemode

TEK page clears screen

Half duplex

Show low level errors

Authenticate

Encrypt

Interrupt, Suspend, Resume

Some hosts expect the keyboard’s DELETE character to delete, others
expect it to backspace. Select the Delete or Backspace button to deter-
mine which character NCSA Telnet sends to the remote host when you
press the DELETE key.

When you check this box, NCSA Telnet always saves the contents of
the screen to the scrollback buffer. This option is available only to
users of full-screen VMS environments, such as DEC All-in-One.

When you check this box, you enable a special compatibility option for
4.3 BSD UNIX. There is an official UNIX bug fix for this problem, but
some hosts may still want CR-NULL used as the end-of-line character.

When you check this box, NCSA Telnet uses linemode with hosts that
support it. If this option is not checked, NCSA Telnet refuses to use
linemode.

When you check this box, NCSA Telnet’s Tektronix emulation clears
the current Tektronix window any time it receives a Tektronix clear
screen command. If you do not check this box, NCSA Telnet creates a
new window for the new Tektronix image. Each new screen created
this way takes the session name and time as its name. For more infor-
mation regarding the Tektronix clear screen command, see “Tek-
tronix-Related Commands in the Session Menu” on page 5-2.

This option applies only to hosts that negotiate nonechoing mode but
do not expect local line editing. If you check this box, all character keys
are sent and echo to the screen immediately. If you do not check this
box, characters echo locally and are queued until you press the
RETURN or CONTROL key. This option has no effect when the Tocal
echo option is turned off.

When you check this box, NCSA Telnet displays minor error conditions
it normally does not. These error messages can be helpful when you
are trying to diagnose a problem with NCSA Telnet.

When you check this box, NCSA Telnet tries to negotiate a Kerberos-
authenticated connection to the remote host, if the remote host sup-
ports authentication and if your Macintosh is properly configured. For
more information regarding authentication, see “Authentication and
Encryption” on page 3-5.

When you check this box, NCSA Telnet tries to negotiate an encrypted
connection to the remote host, if the remote host supports authentica-
tion and if your Macintosh is properly configured. For more informa-
tion regarding encryption, see “Authentication and Encryption” on
page 3-5.

NOTE: You must have an authenticated connection to use encryption.

NCSA Telnet uses certain key combinations for the interrupt, sus-
pend, and resume commands. Default key assignments for these com-
mands correspond to the standard ASCII characters. These three
commands and their default key assignments are:

Interrupt. Interrupt (CONTROL-C) sends a telnet interrupt process
character that is equivalent to selecting Send "Interrupt Process" from the
Network menu (see “Network-Related Commands” on page 3-4). The
host’s implementation of telnet is required to listen for and interrupt
the current application when this function is received.
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Interrupt also does a timing-mark operation (also known as timing-
mark flush and timing-mark processing). In many other implementa-
tions of telnet, pressing CONTROL-C can result in a several-minute
delay while text scrolls on the screen. This occurs because the TCP
protocol has buffered up to 16 Kbytes or even 32 Kbytes of data, which
are waiting in the pipeline to be delivered even before you press CON-
TROL-C. To avoid this scrolling of buffered data, NCSA Telnet initiates
a process known as timing-mark flush any time you issue an Inter-
rupt command.

To do this, NCSA Telnet institutes timing-mark processing by sending
to the host a special character that the host echoes back. The session
appears to pause for up to 15 seconds and then resumes as usual. Dur-
ing the pause, NCSA Telnet throws away all buffered data. You end up
pausing a few seconds instead of waiting several minutes.

Suspend. Suspend (CONTROL-S) instantly interrupts all output from
the network. The current session does not produce any more charac-
ters on the screen until you issue the Resume command.

Resume. Resume (CONTROL-Q) restarts character printing to the cur-
rent session. Resume does nothing unless a Suspend command is in
effect.

Terminal This box contains a popup menu that lets you choose which terminal
configuration record will be used when the alias identifying this ses-
sion configuration record is used to open a session.

Translation Table This box contains a popup menu that lets you choose which transla-
tion table will be initially selected for this session.
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Changing Configuration after Session Connected

Command

Backspace

Delete

Local Echo

Wrap Mode

EMACS arrow mapping

Use the Session menu if you need to change configuration parameters after a ses-
sion connection is opened. Think of the Session menu as table salt: you use the salt
shaker to change food at the table after it’s too late to go back to the kitchen and fix
what you started with.

Backspace
« Delete

Local Echo
+ Wrap Mode
EMACS arrow mapping
+Map PqUp/PgDown/Home/End
Translation [ 2
« Clear Screen Saves Lines
Reset Terminal
Jump Scroll 3#d
TEK Page...
TEK form feed clears screen

Set Screen Size...

Setup Keys... ®S
Font [ 2
Size [ 2
Color...

Capture 5ession to File #EK

Description

When you select the Backspace command, pressing the DELETE key
sends a backspace character.

When you select the Delete command, pressing the DELETE key sends a
delete character.

When you select the Local Echo command, NCSA Telnet operates in
local echo mode (characters are copied to the screen as soon as you
press them on the keyboard). If you have not checkedAllow linemode (see
“Editing Session Configuration Records” on page 2-5), NCSA Telnet
can operate in two different echo modes: local and remote. In remote
echo mode, characters are sent to the host, which sends them back to
be printed to the screen.

Selecting the Wrap Mode command turns on the wrap mode of the VT
terminal emulator. When this command is not checked, wrap mode is
disabled. See also the Use VT wrap mode option in “Editing Terminal Con-
figuration Records” on page 2-4.

When you select this command, pressing arrow keys on your keyboard
sends the appropriate codes to move around in the EMACS editor.
When the EMACS arrow mapping command is not checked, NCSA Telnet
sends the VT codes for the arrow keys.
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Map PgUp/PgDown/Home/End When you select this command, NCSA Telnet uses the PAGE UP, PAGE
DOWN, HOME, and END keys to move around in the session’s scroll-
back buffer. When the Map PgUp/PgDown/Home/End command is not
checked, NCSA Telnet sends the VT codes for these keys.

Translation » The Translation» command opens a submenu that lets you choose the
translation table for the session. In the sample below, no translation is
desired.

+Map PgUp/PgDown/Home/End |

Translation
« Clear Screen $aves Lines 150 8859-1
Reset Terminal DEC Multinational
Jump Scroll #dJ| PC 850
TEK Page... |
Clear Screen Saves Lines When you select this command, all lines currently displayed on the

screen scroll into the scrollback region before the screen is cleared. If
Clear Screen Saves Lines is not checked, the cleared lines are perma-
nently erased when the screen is cleared.

Reset Terminal When you select the Reset Terminal command, NCSA Telnet resets all VT
mode settings, disables wrap mode, resets VT graphics mode, resets
the keypad mode to the default, and resets tabs to every eight spaces.
Use this command, for example, when a host program accidentally
sets VT graphics mode or fails to leave VT graphics mode.

Jump Scroll Select the Jump Scroll command if you want to skip to the end of the
local buffer. The screen pauses, then jumps ahead over scrolling text.
The text is placed into the scrollback buffer, but the screen advances
to the end of the local network buffer instead of printing every line on
the screen. The purpose of this feature is to save time. For example, if
you enter a command that produces a great deal of output, you can
use the Jump Scroll command so you do not have to wait for the output
to scroll by.

TEK Page... When you select the TEK Page... command, you can quickly create or
clear a Tektronix emulation window without intervention from host soft-
ware. Normally the emulation window appears automatically when the
clear screen command sequence is received from the host, but the
TEK Page... command creates the window immediately.

To clear the current session window, use the TEK Page... command the
same way you use the PAGE key on a Tektronix terminal.

The TEK Page command is disabled when you select Inhibit as the TEK
Emulation in the session configuration record that creates this ses-
sion.

For more information, see the description of TEK options in “Editing
Session Configuration Records” on page 2-5. See also “Starting a Tek-
tronix Emulation” on page 5-1 and “Tektronix-Related Commands in
the Session Menu” on page 5-2.

TEK form feed clears screen When you select this command, NCSA Telnet’s TEK emulation does not
clear the screen when it encounters a form-feed command. TEK images
often conclude with a form feed command so that the TEK screen
clears as soon as it reaches the end of an image. However, immediately
clearing the screen makes it hard to see the final image of a TEK file.
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Set Screen Size...

Select this command to change the size of the VT emulation screen.
NCSA Telnet’'s VT emulation screens defaults to 24 lines because an
actual VT terminal screen has room for 24 lines of text. Some host sys-
tems let you define a VT-like terminal type with more or fewer than 24
lines. You can change the NCSA Telnet VT emulation screen default by
editing the terminal configuration record. See the description of the
Screen Width and Screen Height options in “Editing Terminal Configura-
tion Records” on page 2-4.

How to Reset Screen Size. If you change the size of the VT emulation
screen, the session window resizes itself to reveal the entire VT
screen. To increase or decrease the size of the VT emulation screen
from the Session menu:

First select Set Screen Size... from the Session menu. The Select Screen
Dimensions dialog box appears, showing the current number of lines
and columns in the VT emulation screen.

Select Screen dimensions

Number of Lines: 35

Mumber of Columns: (80

Change the values as desired, then click the OK button (or press the
RETURN key) to return to your session window. Click the Cancel button
to abort the change.

Shortcut to Reset Screen Size. To quickly change the size of the VT emula-
tion screen, hold down the OPTION key while you use the size box to
resize the window. As the window changes size, NCSA Telnet recalcu-
lates the number of lines in the window and displays the current
dimensions in the upper-left corner of the window. When you release
the mouse button, the new size of the VT emulation screen is set. This
method is equivalent to selecting Set Screen Size from the Session menu.

NOTE: Resizing a session window without holding down the OPTION
key only resizes the Macintosh window and does not change the size
of the VT emulation screen.

Warnings and Suggestions. If you do not have a good working knowledge
of how your host system uses terminals with more than 24 lines, we
recommend that you use only 24-line windows. The following warn-
ings and suggestions assume that you are familiar with UNIX-based
software to control the number of lines for the terminal. Consult your
host system documentation or system administrator for more infor-
mation.

The termcap file, which is found only in UNIX systems, is commonly
located in the /etc/termcap file. It can be set up to include the num-
ber of lines on the terminal. The default VT100 termcap file explicitly
sets a 24-line window, so even if you enlarge your NCSA Telnet win-
dow, the host uses only the top 24 lines. You can create special term-
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cap entries by editing the /etc/termcap file; copy the VT100 entry to
anew name and change the number of lines to your preferred screen
size.

Berkeley UNIX-based systems have a special feature in the stty pro-
gram. The number of rows in a session window can be set to any value,
and applications programs such as vi learn your window size from the
stty setting. To set the window size to 33 lines, enter stty rows 33.

You can use the special macro variable # to create a macro that issues
this command and automatically substitutes the number of lines for
the current window. For example, you could define the macro for 38-0
as stty rows \#. Now you can reset the window size by pressing 88-0,
then RETURN. The sequence \#is replaced with the proper number of
lines. For information about creating and saving macros, see “Macro
Definitions” on page 2-15.

Some systems have a program installed called resize. The resize pro-
gram sends a special sequence of VT control characters to NCSA Tel-
net’s VT emulator to determine the size of the screen. If resize is
available on your system, adding resize > /dev/null to your
.cshrcor .login file automatically sets your screen size correctly
when you log on. To determine if the resize program is available at
your site and for help using it, contact your system administrator.

NAWS (Negotiations About Window Size). NAWS is a relatively new option in
the telnet standard. UNIX hosts that support NAWS allow NCSA Telnet
to send information to the host regarding the VT window size. Conse-
quently, when you select Set Screen Size... from the Session menu to
change the VT screen size , the new screen size is sent over the net-
work to the host and you do not need to use the stty program. The
host knows how big the window is, which eliminates possible prob-
lems for screen-oriented applications such as the vi editor.

NOTE: NAWS is not supported by all UNIX machines. You can deter-
mine if the host you are connected to supports NAWS by changing the
size of the VT emulation screen and then asking the remote host for
the screen size. If the host responds with a screen size that matches
the new screen size you have just set, the host supports NAWS.

Setup Keys... Use the Setup Keys... command to select which keys, if any, issue the tel-
net commands interrupt, suspend, and resume. See the description
of the Interrupt, Suspend, Resume options in“Editing Session Configura-
tion Records” on page 2-5.

Font » The Font» command opens a submenu containing the fonts you can
use to display text in a session window. When you select a font from
this submenu, the current window is resized to contain the text and
the selected font is used to display all text in the current window.

NOTE: Proportionally spaced fonts—which include most fonts except
Courier and Monaco—display slowly and appear spread out.

Size P The Size» command opens a submenu that contains the point sizes
you can use to display text in a session window. The submenu lists
several sizes, checks the current size, and outlines all sizes in your
system. When you select a point size from this submenu, the current
window is resized to contain all the resized text and the text is
redrawn according to the specified point size.
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Color...

Capture Session to File

NOTE: Sizes that are not outlined in the submenu must be scaled by
the system software and therefore may be slow and less sharply
defined than nonscaled point sizes.

The Color... command applies only to Macintosh computers that are
color-equipped. To change the foreground and background colors of
the current window for both normal text and blinking text:

First select Color... from the Session menu. The Color Selection dialog box
appears:

Morrmal Text
Marrnal Background

Elinking Te:xt

Elinking Background

ALl

Then click the box next to the item to which you wish to assign a color:
Normal Text, Normal Background, Blinking Text, or Blinking Background. This
opens the Color Wheel dialog box. Select a new color by clicking in the
color wheel. The color you select appears in the top rectangle under
the heading Please Select New Color. Click OK (or press the RETURN key)
to set the color change and return to the Color Selection dialog box. The
box next to the item you selected in Step 2 reflects the color you chose
from the Color Wheel dialog box. Repeat to assign colors to other items
in the Color Selection dialog box. Click OK when you are done choosing
colors. The new colors are applied to your current session window.

For additional information on using the Color Wheel dialog box, refer to
your Macintosh System Software User’s Guide.

NCSA Telnet can save the text from a session to a file. When you select
thiscommand, all normal text output that appears on the screen is also
saved to whatever file you specify in the Save File dialog box. When the
Capture Session to File command is not checked, this functionality is
turned off.

Saved Sets

NCSA Telnet makes it easy for you to begin multiple sessions quickly. If you use
saved sets, you can log on and get right to work without resetting the special char-
acteristics and configuration of a connection each time you start up.

A set—a snapshot of open sessions and their current configurations—consists of
current macro settings and each session’s window location and size, connected
host, window name, scrollback setting, color, font, font size, backspace/delete set-
tings, and all other configuration information.
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Saving a Set
To save a set:
1. Log on to the desired host as instructed in “Logging on to Your Host” on
page 1-3.

2. Customize the session by moving the session window to an ideal location on
the screen, specifying a background or text color, choosing a font and font
size, setting the desired number of scrollback lines, and choosing the function
for the BACKSPACE/DELETE key.

3. Select Save Set from the File menu.
4. A File dialog box appears and prompts you to name the set.

5. After naming the set, click on the Save button in the dialog box to save the set.

Using a Saved Set

Saved sets let you bypass the start-up procedure described in “Opening and Clos-

ing a Connection” on page 1-2. Specifically, you do not need to select Open Connec-
tion from the File menu (or press 38-0) or to specify the connection host or window
name. These operations are performed automatically when you load a set.

After you load a set, the session window automatically appears for the specified
host at the specified location on the screen and with the specified window name,
scrollback setting, color and other characteristics. The following characteristics are
saved in a set:

Session name

Hostname

Port number

Window size and location

Scrollback setting

BACKSPACE/DELETE key setting

Macro definitions

Command-key setting

Number of columns

Tek clear-screen setting

Font and font size

Color characteristics

Assigned keys for Interrupt, Suspend, and Resume functions

CRMAP setting

Linemode setting

Eight-bit status

Translation table setting

TEK emulation setting

Answerback message
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Loading a Saved Set

From the Finder

To load a set from the Finder and automatically invoke NCSA Telnet, double-click
on the saved-set icon or filename. The sample below shows the saved-set icon for a
set named Setup One.

o

Setup One

From within NCSA Telnet
To load a set from within the NCSA Telnet application, select Load Set from the File
menu. In the File dialog box that appears, select and open the set.

NOTE: You can edit a set datafile using any editor capable of editing files, even if
the datafile’s Macintosh file type is not TEXT. However, don’t rely on this feature
because it may not work with future versions of NCSA Telnet.

Macro Definitions

NCSA Telnet lets you use the key combinations 8-0 through 88-9 as macro keys.
You can program these keys to send from O to 255 characters.

To define a macro:

1. Select Set Macros from the Edit menu or press 38-M. The Macro Configuration dialog
box below shows several sample macro definitions.

3 B ® E E

AR

stty rows “#

Is -1 \r

ftp i

& 33 E E

2. Click on the button of the command key you wish to define, or select the box
next to that button.

3. Enter the appropriate macro key sequence. Unless you are familiar with the C
programming language, the key sequences that generate special control char-
acters in a macro may seem somewhat strange. To define a special character,
you must first enter a backslash (\). Indicate nontypable control characters
with their equivalents in the octal numbering system. Some common macro
key combinations you might want to enter are listed below.
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4. Click on the OK button (or press the RETURN key) to activate the new macros,
or click on the Cancel button to invalidate the additions or changes you made.
Clicking either OK or Cancel returns to the application.

Common Macro Key Combinations

Desired Character Definition
Backslash (\) A\

TAB \t

ESC \033
CONTROL-C \003
CONTROL-D \004
CONTROL-E \005

CONTROL-H or BACKSPACE \010

Size of current window \# (Refers to setting the number of usable lines in a session win-
dow. See the Set Screen Size command described in “Changing Configu-
ration after Session Connected” on page 2-9.)

Internet address of this Mac \i (See also the descriptions of the Show Network Numbers com-
mand in “Network-Related Commands” on page 3-4 and the Send IP
Number command in step 3 of “Issue the FTP Command” on page 4-6.)

Reverting to Previous Macro Definitions

While you are working in the Macro Configuration dialog box, you can undo changes
you made to a macro and also revert the associated command key to its previous
setting—just click on the button corresponding to that command key. For example,
to undo changes to the definition for 8-2, click on the 382 button. To simulta-
neously abandon all changes you have made, click on the Cancel button.

Saving Macros

Currently the only way to save your macro settings is in a saved set. See “Saved
Sets” on page 2-13. NCSA plans to extend the macro capability of NCSA Telnet in
future versions.
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3 Advanced Features

This chapter covers more advanced aspects of the working environment of NCSA
Telnet for the Macintosh. It describes how to use the mouse to position the session
cursor, open multiple connections, implement commands from the Connections and
Network menus, and use authentication and encryption.

Cursor Positioning with the Mouse

You can use the mouse to position the session cursor if you are using a full-screen
editor that supports the arrow keys. One such editor is vi. When the mouse cursor
is in a session window, holding down the OPTION key changes the mouse cursor
into a rectangle. When the mouse cursor is in the session window, holding down
the OPTION key and simultaneously pressing the mouse button instructs NCSA
Telnet to send a sequence of arrow keys to move to that position on the screen.

NOTE: If your editor is EMACS rather than vi, you should either set the EMACS arrow
keys option in the session configuration record or check the EMACS arrow mapping
command in the Session menu

Multiple Connections

NCSA Telnet lets you use multiple connections, either to a single host or to several
different hosts.

Opening More Than One Gonnection
To open another connection, follow either the opening-a-connection procedure
presented in “Opening and Closing a Connection” on page 1-2 or the saved-set
instructions in “Loading a Saved Set” on page 2-15.

The active session is the connection with which you are currently working. The
active session’s window is generally frontmost on your desktop.

Moving hetween Connections
To switch between sessions and to make a new session window your active session,
bringing it to the front, either click on the session window for the desired connec-
tion or select the desired session name from the Connections menu.

NeHt Session EN
Change Window Title...

«compled.ccsr.uiuc.edu 4
danube.ncsa.uiuc.edu 5

To activate the session window directly beneath the current session window, select
Next Session from the Connections menu or press 38-N (for next).



NCSA Telnet opens new session windows on the screen relative to the number of
windows currently opened. You can specify that these windows be staggered by
just a few pixels or by the whole window title bar. See the description of the Stag-
gered Windows option in“Global Preferences” on page 2-1.

Rules for Session Names

When you open multiple connections to a single host, it is useful to specify session
names (other than the hostname) for the connections. You may use any of the fol-
lowing for session names:

the host’s full Internet address, such as 192.17.22.20

any session configuration record alias (see “Editing Session Configuration
Records” on page 2-5)

any name, such as sri-nic.arpa, that can be resolved by the domain-based
nameserver

NOTE: Some systems, such as MFENET, do not use the standard telnet port number
23.1f you need access via the telnet protocol to a different port number, in the Open
Connection dialog box enter the port number after the session name; the session
name and port number must be separated by one or more spaces. For example, to
open a connection to port 23 of myhost.network.arpa, in the Host/Session Name
box of the Open Connection dialog box, enter myhost.network.arpa. To open a con-
nection to port number 911 of the same host, enter myhost.network.arpa 911.
You can also specify alternate port numbers in your session configuration records.

The Gonnections Menu

Naming Windows

You can specify titles that are different from the session names for your session
windows so that you can easily distinguish between multiple sessions and session
windows.

To specify a window title, enter the desired name in the Window Name box of the
Open Connection dialog box.

NOTE: If the Window Name box is blank when you open a connection, NCSA Telnet
automatically numbers the session. Each time you open a session, the number
increases, no matter how many sessions are currently open.

Checking Session Status

The Connections menu contains the window names for current connections and the
status of each session. A checkmark (v/) next to a window name indicates an active
session, and a diamond (#) or circle (-) next to a session name indicates an
attempted connection that has not yet successfully opened. More specifically, a
diamond indicates that NCSA Telnet is checking the nameserver to find the session
name or hostname; a circle means NCSA Telnet is trying to open the session. Once
the connection is established, the diamond or circle next to the session name goes
away and the session window appears.
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NOTE: If you do not remember the meaning of these symbols, select Marked Connec-
tion from the Connections menu. The Connection Status dialog box then reports the
name and status of the connection. After you read the message, click the OK button
(or press RETURN) to proceed with opening the connection, or click the Abort button
to cancel the attempt.

Janos is currentiy

being opened

Ahorting Connection Attempts

To abort an attempted connection attempt:

1. Select the desired connection from the Connections menu. The Connection Status
dialog box appears, reporting the name and status of the connection.

2. Click the Abort button in the Connection Status dialog box.

Changing a Window Title

Select Change Window Title... from the Connections menu to change the window title of
the frontmost window.

The Network Menu

NCSA Telnet supports several special commands defined by the Internet standard
telnet protocol. Each host telnet implementation treats these commands differ-
ently, so they may have no effect on some hosts.

The Network menu includes seven telnet commands as well as two network-related

commands:

Send FTP Command #F
Send IP Number |
$end "Are You There?" ®/
Send "Abort Output” #A
Send "Interrupt Process" %Y
$end "Erase Character"” #H
Send "Erase Line" #=U
Suspend Network
Show Network Numbers...

Telnet Commands

Command Description

Send FTP Command When you select this command, NCSA Telnet sends an FTP command

to the remote machine. Normally the command is ftp w.x.y.z (where
w.x.y.z is the IP address of your Macintosh) followed by a return char-
acter. However, if the FTP server is in anonymous mode, NCSA Telnet
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sends the command ftp -n w.x.y.z followed by a return character.
You can force NCSA Telnet to omit the -n option if you hold down the
SHIFT key. For more information about FTP commands, see “File
Transfer” on page 4-1.

Send IP Number When you select this command, NCSA Telnet sends the IP address of
the Macintosh you are using to the remote machine as if you typed it in
manually.

Send "Are You There?" Use this command whenever you are not sure whether the network

and host are up. Every once in a while, especially when the host is bom-
barded with incoming information or tied up by a large number of
users, the host doesn’t seem to respond to your commands. When this
happens and your terminal appears to have locked up, you can select
this command to determine whether you are still connected to the
host. The host is supposed to respond, if able, with a readable mes-
sage. Some machines answer Yes; others answer with more informa-
tive messages.

Send "Abort Output" This command is supposed to throw away all output from the current
process and then resume when there is a pause. Very few hosts imple-
ment this command correctly.

Send "Interrupt Process" Available on nearly every telnet host, this command stops the current
process and throws away all pending data for the connection. It is
equivalent to pressing CONTROL-C on most UNIX systems. You can set
your Macintosh keyboard so that CONTROL-C sends the Send "Interrupt
Process" command; select the Setup Keys... command in the Session
menu, as described in “Changing Configuration after Session Con-
nected” on page 2-9.

Send "Erase Character" and

Send "Erase Line" You can erase either the last character or the current line by selecting
Send "Erase Character” or Send "Erase Line", respectively. Many hosts do
not implement these commands but use their own special characters
instead.

Network-Related Commands
The Network menu includes two of NCSA Telnet’s network-related commands:

Command Description

Suspend Network Select this command to temporarily suspend all network communica-
tions and disable all receive functions. All of your connections are kept
alive, but you do not see any incoming text.

NOTE: Generally you should use the Suspend and Resume commands
rather than the Suspend Network command. See the discussion of the
Interrupt, Suspend, and Resume commands in “Editing Session Con-
figuration Records” on page 2-5.

Show Network Numbers Because NCSA Telnet now uses MacTCP for all network communica-
tions, this command is largely unnecessary. However, for purposes of
continuity, selecting this command displays your Macintosh’s IP
address in a dialog box but does not transmit the address. Click on the
dialog box to remove it.
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Authentication and Encryption

NCSA Telnet supports Kerberos Version 4 authentication (from Cornell University)
and DES encryption.

Computer users traditionally have entered passwords to log on to their accounts
on hosts. While passwords have provided some level of security, a proliferation of
methods for snooping passwords off the Internet has greatly reduced the security
provided by passwords.

Kerberos provides a system that authenticates a user to hosts. After you enter your
password once, that password is usedto gain a ticket from a Kerberos server. You
use this ticket to log on to Kerberos-aware hosts without entering your password:
the ticket guarantees that the person making the connection is who you say you are
(i.e., because you are the authentic person, you are authenticated). The method
used to gain the ticket does not require that your password pass over the network
in an easily snooped form.

Even with the authentication features of Kerberos, NCSA Telnet connections are
still subject to snooping. Data you send and receive can be snatched from the net-
work and viewed by others. However, when NCSA Telnet sets up an encrypted con-
nection, data are scrambled before passing between your Macintosh and a remote
host. Such data are significantly more protected than unencrypted data. Encryption
is not foolproof, but it does stop the majority of attempts to snoop through your
data.

NCSA Telnet requires that an authenticated connection be in place before using
encryption.

Preparing Your Environment

NCSA Telnet uses Cornell University’s Kerberos driver package (Kdriver) for Ker-
beros and encryption support routines. Kdriver, which supports Kerberos Version
4, requires that each Kerberos server host also run a UDP daytime server. KConfig
(an application written by Rick Watson of the University of Texas) is used to config-
ure Kdriver settings.

You can download the Kerberos Client extension and the KConfig application
from NCSA’s anonymous FTP server. (See “Anonymous FTP Server” on page C-1.) If
you use a version of the Cornell Kerberos driver obtained from a source other than
NCSA, encryption is not supported, some setting changes made by KConfig won’t
be saved in the Preferences file, and the ticket may display garbage for the user
realm.

You also need to know pertinent information regarding your site’s Kerberos server.
If you are an administrator, you need to install a Kerberos server for your site.
Installing a Kerberos server is beyond the scope of this manual.

NCSA Telnet for the Macintosh Version 2.6 supports the telnet authentication and
encryption options described in the RFC1411/1416 and IETF drafts dated July
1991. Future versions may support the IETF draft AUTH_ENCRYPT option
described in the draft dated April 1993.

Installing Software

To implement either authentication or encryption, you must install Kdriver in the
System folder on your Macintosh. Drag the Kerberos C11ient extension to your
closed System Folder. If you are running System 7, you are asked to verify that the
file is to be placed in your Extensions folder.

Advanced Features [1 3-9



Reboot your Macintosh and use KConfig to configure settings for your Kerberos
environment. All KConfig settings are made in the Kerberos Configuration window.

Mapping Kerberos Realms to IP Names
This section assumes you are familiar with Kerberos.
A domain/hostname-to-realm map attempts to match a Kerberos realm with IP

domain names. Use KConfig to set up domain/hostname-to-realm maps, which are
useful if you support more than one Kerberos realm.

You may (or may not) have to reboot after entering your initial settings in the Ker-
beros Configuration dialog box.
— |
Kerberos Configuration

Local Realm: |SNAGATE. -
Metwork username: rick

Domain/Hostname Realm
Adp.utexas edu SHAGATE ﬁ MNeLw
fEeisrie
6 E¥ 31
Server IP address Realm
utxrzékb.dp.utexas edu SHAGATE ﬁ MNeLw
fEeisrie
6 E¥ 31

[ Login ] [Luguut] [Ehange passu.lurd]

Option Description
Domain/Hostname . . . Realm Enter the domain or host name for each Kerberos host you are using.
Server IP address . . . Realm Enter the Kerberos server’s IP address or hostname for each Kerberos

realm you are using. After entering your Kerberos servers, you can
pick your local realm using the Local Realm: popup menu at the top of
this dialog box.

Login Click this button to authenticate to a Kerberos server and obtain an
initial ticket-granting ticket for other services. You don’t have to log on
using KConfig; NCSA Telnet prompts you when a password is needed.

Logout Click this button to destroy all tickets. Select Show Credentials from the
File menu to display all your Kerberos tickets.

Change Password Click this button to change your Kerberos password.

Activating Authentication and Encryption in NCSA Telnet
Authentication and/or encryption options appear in two places in NCSA Telnet:

In the Open Connection dialog box. See “Opening a Connection” on page 1-2.

In the Session Configuration Record dialog box. See “Editing Session Configuration
Records” on page 2-5.
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In the Open Connection dialog box, you can select the Authenticate and Encrypt options
when you open a session. These options apply to the default session.

Host/Session
Mame

=]

Window Name | |

|datamaster.muuf.cum

C]FTP session [3F)
] Authenticate (#A)

O] £serynt =i}

NOTE: The Authenticate option is required for encryption. FTP sessions cannot cur-

rently be authenticated or encrypted.

In the Session Configuration Record dialog box, select the appropriate options for each
session that you configure, including the default session.

Hostnarme |akbar.cc.utexas.edu

Fart
TEK (@) Inhibit EEE 4105
Paste Method (3 Quick () Block
Delete Sends W Delete [ Backspace

|:| Forcesave

|:| Berkeley 4.3 CR rode

E Allow Tinernode

|:| TEK page clears screen
|:| Half duple:x

|:| Show Tow lewel errors
E Authenticate

E Encrypt

Terrminal | <Default: Translation Table

Interrupt
Suspend

Resurne

UL

Indicating Active Encryption

NCSA Telnet displays encryption icons next to the zoom box in the window’s title
bar. For example, see the padlock icon below:

A padlock icon indicates that a session is two-way encrypted, which means that
data are encrypted both going to and coming from the server. If any other icon is
displayed, the session is not two-way encrypted. An arrow indicates that the ses-
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sion is encrypted in one direction only—either boging to or coming from the
server—and is probably evidence of a bug in either the NCSA Telnet code or in your
telnet server. The absence of any icon means that no encryption is taking place.
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4 File Transfer

This chapter discusses File Transfer Protocol (FTP) as well as various features of
NCSA Telnet for the Macintosh for transferring Macintosh and other files.

File-Transfer Terminology

The following terms are frequently used in this chapter:

ASCII file

Binary file

Client/server

File transfer

MacBinary file

An ASCII, or text, file is one that you can read. You can use it with
standard editors on the Macintosh or host. When text files are
transferred, they are translated to a format appropriate for the
receiving machine.

A binary, or image, file cannot be read by standard text editors.
Unlike ASCII text files, binary files are not changed in any way
when transferred.

The client is the computer system that requests services, and the
server is the system that provides services.

The client is not always your Macintosh, despite appearances.
When you use NCSA Telnet to connect to a host, your Macintosh is
the telnet client. When you request a file transfer from your Macin-
tosh, the transfer is actually initiated on the host, making the host
the FTP client and your Macintosh the FTP server. Your Macintosh
can be both a telnet client and an FTP server at the same time.

In a file transfer, the contents of a file are copied to a file on
another computer.

A MacBinary file has been encoded in the MacBinary file format so
it can be stored for downloading later to a Macintosh. Because the
file contains all the information contained in a normal Macintosh
file, a MacBinary file can be used for transferring applications and
other Macintosh-specific files. MacBinary files are virtually useless
on any other machine.

About FTP and NGCSA Telnet

NCSA Telnet has an internal FTP server that permits reliable file transfers between
a Macintosh and any FTP host on the network. File transfers are initiated from the
FTP host. With the NCSA Telnet implementation of FTP, you can:

Stream transferring files in either text (ASCII) or binary (image) format

Change the directory

Show the name of the current directory

List files in the current directory (with wildcard specifications)

Send and receive multiple files with one command (using wildcards)



File transfers are processed in the background. While a file transfer is in progress,
you can perform other NCSA Telnet activities such as switching sessions, adding
new sessions, or changing parameters. When one FTP connection is active, requests
for another are ignored.

Using an FTP Client

NCSA Telnet lets you use an FTP client to connect directly to the FTP port of a host
machine, which means you can transfer a file directly between the remote host and
your Macintosh.

This is simpler than the normal process, which requires you to log on to a UNIX
account, transfer a file from the remote host to your UNIX account, and finally
transfer the file from your UNIX account to your Macintosh.

When you use an FTP client to transfer files directly between a UNIX host and your
Macintosh, you do not need to log on to a secondary UNIX account for FTP to use as
a temporary go-between.

Follow these steps to log on to and use an FTP client:

1. Select Open Connection from the File menu. The Open Connection dialog box
appears.

2. In the Open Connection dialog box, check the FTP Session box. This opens a win-
dow displaying an FTP client connection message similar to the one below:

_——— 12 4 EEEI
220 w2 FTP server (lersion 3.2 Fri Sep 7 14:09:58 COT 19903 ready.

Tl

Checking the FTP Session box is exactly the same as opening a connection to a
UNIX machine on port 21, which is the FTP port. Therefore, if you set up an
alias to port 21 of a remost UNIX host, all sessions opened to that alias are FTP
clients. For more information about aliases and session configuration records,
see the description of the Alias option in “Editing Session Configuration
Records” on page 2-5.

3. Enter user followed by your login name and press RETURN. Example:
user loginname RETURN
4. The host prompts for your password. Enter your password and press RETURN.

If you are logged on successfully, the host sends a message that you are con-
nected properly.

Once logged on, use the FTP client just as you would normally use an FTP session.
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Configuring an FTP Server

To configure an FTP server, select Edit» FTP Server from the Preferences menu. The
FTP Server Preferences dialog box appears:

Server Mode D off

|:| Show FTF log at startup

E Usze Macbinary 11

E Reset Mackinary after each transfer
|:| Usze IS0 Translation

BinargFﬂetgpe|BlNA | Ereat-:-r|???? | [EHEIITI[IlE]

FTF Server Prefs

D 0On, Mo passwords needed
@ On, Uzername & Password required

Text Creator | thxt [Select pr"cﬂtiun]

Each option in this dialog box is described below.

Option

Server Mode

Show FTP log at startup

Description

NCSA Telnet’s FTP server can operate in three modes: off, on with no
passwords, and on with passwords. When you select Off, NCSA Telnet
refuses all FTP connections to your Macintosh. When you choose On, No
passwords needed, NCSA Telnet allows anyone to connect to your Macin-
tosh through FTP. When you select On, Username & Password required,
NCSA Telnet requires connecting users to supply a valid username and
password before gaining access to your Macintosh through FTP.

WARNING: Do not leave the FTP server in On, No passwords needed. This
mode allows anyone access to your entire filesystem. NCSA Telnet
includes this mode merely for quick and simple file transfers. It is not
appropriate for a permanent configuration setup.

For information regarding the configuration of usernames and pass-
words for FTP, see “Controlling Access” on page 4-4.

When you check this option, the FTP log is displayed when NCSA Tel-
net is launched. The FTP log shows current and past transactions:

FIP Log B"——

FTF transferring: mbox
FTF Transfer Concluding
FTF Transfer Concluding
FTF transferring: Connections Menu
FTF Transfer Concluding
FTF Transfer Concluding

Use Macbinary Il

When you select this option, NCSA Telnet uses MacBinary transfer
mode when in binary mode. You can turn MacBinary mode on and off
either from this dialog box or by sending quote macb enable or
quote macbh disable to the FTP server.

File Transfer O 4-3



Reset Macbinary after each transfer ~ When you select this option, the MacBinary transfer mode returns to
your preferred default (enabled or disabled) each time you open a new
FTP session, regardless of how you set the mode in a previous session.
This saves you the trouble of tracking whether Macbinary transfer
mode is enabled each time you want to transfer files.

NOTE: Each FTP session corresponds to the opening of each FTP com-
mand connection, not to the individual file transfer.

Use ISO Translation When you select this option, filenames sent in directory listing to the
connected FTP user are first translated into the International Stan-
dards Organization (ISO) character set.

Binary Filetype and Creator Use the Binary Filetype and Creator boxes to specify the file type and file
creator type for files transferred in binary mode when MacBinary
transfer mode is disabled. Clicking on the Example button opens the File
dialog box; use the the dialog box to select a file, then determine that
file’s file type and file creator type. For more information regarding
file types and file creator types, see the discussion of the Capture File
Creator option in “Global Preferences” on page 2-1.

Text Creator Use the Text Creator box and Select Application button to select the four-
letter file creator type given to files transferred to your Macintosh
through ASCII transfer mode.

Controlling Access

To control who has FTP access to your Macintosh, select Preferences » FTP Users from
the Edit menu. An FTP Users Preferences dialog box appears that is similar to the fol-
lowing, which lists three users (jbrowne, melliott, and uldhmi):

melliott
uldhirni Changs
Bennuy
C

Highlighting a username, then clicking on the Remove button cancels that user’s
access privileges.
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Clicking on either the New or Change button opens a dialog box similar to the one
below, which lets you add a new FTP user or change information about an existing
FTP user:

Usernarne | jbrowne |

Faszword | (ITTITIT T |

Default felatédrivel £
Crirectory

[Ehange Default I]irec:turg]

In this sample, the user receiving FTP access is jbrowne, whose password is not
displayed. When jbrowne logs on, his default directory will be /sTot6drivel/.

Option Description

Username In this box enter the name you want NCSA Telnet to recognize at the
username prompt.

Password Enter the user’s password in this box. Newly entered passwords are
displayed in normal text. When you change records, this box always
displays eight bullets (-) regardless of the length of the actual pass-
word. Passwords are stored in an encrypted format in the preferences
file.

NOTE: The encryption method used on passwords is quite simple and
prevents casual users from discovering your passwords. But you
should never give anyone a copy of your Preferences file.

Default Directory When a user logs on with the correct username and password, NCSA
Telnet’s FTP server sets the working directory to the default, which is
identified here. Clicking on the Change Default Directory button lets you
change this user’s default directory.

Preparing to Transfer Files

Before you attempt to transfer files using FTP, make sure the following conditions
are met:

Your host system supports FTP file transfer. If you do not know whether it
does, see your system administrator.

You have not disabled the file transfer capability of NCSA Telnet. You can
check two conditions to determine whether the FTP capability is disabled:

» In the FTP Server Preferences dialog box, Server Mode is set to Off. Change this
setting to On.

» When you attempt to start up FTP, your machine does not respond to the
FTP command. Check to see if you have configured the FTP server.

File Transfer O 4-5



Invoke FTP on the Host
Since the remote host initiates FTP transfer, FTP commands vary depending on the
host system. For full documentation of FTP and commands within FTP, refer to the
manuals for the host computer. On UNIX systems you can read online documenta-
tion by entering:

% man ftp

Issue the FTP Gommand
On most computer systems, at the prompt you enter the FTP command and the IP
name or IP address of the target machine.
You can enter the FTP command in one of three ways. Use whichever method you
are comfortable with. In the following examples of the three procedures, the IP
name of the Macintosh is mymachine and its IP number is 192.17.20.22:

1. Enter either the machine name or IP address and then press RETURN:
% ftp mymachine or % ftp 192.17.20.22

2. Select Send FTP Command from the Network menu (or press 38-F). Either causes
NCSA Telnet to enter the FTP command and issue a return character.

3. Enter ftp, press the SPACEBAR key, select Send IP Number from the Network
menu (which automatically enters your IP address), and then press RETURN.

Your host computer may not accept FTP commands from any of these procedures,
so you may have to test some variations to find the easiest method for your site.

Regardless of how you invoke FTP, most FTP clients respond like this:

Connected to 192.17.20.22.
220 Macintosh Resident FTP server, ready
Name (192.17.20.22:uldhmi):

Most FTP clients prompt for your username and password. If you have configured
the FTP server for passwords (see “Configuring an FTP Server” on page 4-3), then
you must enter a password. Otherwise, press RETURN to bypass the prompts. If
you are not prompted for a username and password, assume that you are logged
on and enter your FTP commands at the FTP prompt.

NOTE: When an FTP connection is active, the cursor changes to a small file icon:

When the FTP connection terminates, this icon changes back to the standard
I-beam cursor.

Enter Additional FTP Commands

After FTP is invoked and passwords are checked, most FTP clients prompt you for
individual FTP commands. These commands are documented in manuals for the
host computer. Most FTP implementations have similar commands because they
are modeled after the Berkeley UNIX version of FTP.

Once you are in FTP, you can access online help for a list of available commands.
FTP commands that are common to most implementations are listed below:

Command Action

ascii Sets mode to ASCII (text) transfer mode, which is the default
binary Sets mode to binary (image or I) transfer mode

cd Changes the directory on your Macintosh
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dir Shows filenames in the Macintosh’s default directory

get filename Gets specified file from the Macintosh and sends it to the host
help Shows an online list of FTP commands

put filename Sends specified file from the host to the Macintosh

pwd Shows the name of the current Macintosh directory

Set the Transfer Mode

ASCII is the default mode for FTP transfers. To transfer graphic or binary data files,
you must change the transfer mode to binary format before you enter the put or
get commands that transfer files. To set the transfer mode to binary, enter either
binary or bin.

If you intend to use the file you are transferring with a Macintosh-specific applica-
tion, you may also need to set MacBinary transfer mode. See “MacBinary Files” on
page 4-9.

To set or reset the transfer mode to ASCII format, enter ascii.

Examples in “Transferring Files” on page 4-7 demonstrate FTP transactions with an
ASCII file and with a binary file.

Change the GCurrent Directory

FTP transfers files to the default directory on your Macintosh. To change the direc-
tory, enter cd at the FTP prompt (ftp>).

The cd command (which is one of the common FTP commands) requires you to
manually specify a directory by entering a pathname; you do not use a dialog box.
In the directory’s pathname, the Macintosh requires that you enter a colon (:) or
slash (/) to separate folder names.

For example, to change the default directory to a directory named myfolder on your
local Macintosh named hdZ20, enter one of the following at the FTP prompt:

ftp> cd ":hd20:myfolder" or ftp> cd "/hd20/myfolder"

To identify your default transfer directory, enter the pwd command at the FTP
prompt. In our example, entering the pwd command after the preceding cd com-
mand results in:

ftp> pwd

"/hd20/myfolder" is the current directory

Transferring Files

To a Macintosh

Now you are ready to transfer files via FTP.

WARNING: Do not close an NCSA Telnet connection while a file transfer is in
progress. Trying to do so causes the file transfer to fail.

Even though you seem to be initiating the transfer from the Macintosh, the transac-
tion actually operates from the host. For example, to transfer a file from the host to
your Macintosh, enter the put command:

ftp> put filename.ext

The following example demonstrates how to use the put command to transfer an
ASCII (text) file named temp2 from a remote host to a local Macintosh:
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% ftp -n 192.17.20.124

Connected to 192.17.20.124.

220 Macintosh Resident FTP server, ready
ftp> put temp2

200 This space intentionally left blank < >
150 Opening connection

226 Transfer complete

262145 bytes sent in 32.61 seconds (7.8 Kbytes/s)
ftp> quit

221 Goodbye

%

To a Host
To send a file from your Macintosh to a remote host, enter the get command:
ftp> get filename.ext
The following example demonstrates how to use the get command to transfer a
binary (image) file named bridge. pic from a local Macintosh to a remote host.
The cd command is used to locate the directory, /HD20/pictures, in which the
file resides.
% ftp -n 192.17.20.124
Connected to 192.17.20.124.
220 Macintosh Resident FTP server, ready
ftp> bin
200 Type set to I, binary transfer mode
ftp> cd "/hd20/pictures"”
250 Chdir okay
ftp> get bridge.pic
200 This space intentionally left blank < >
150 Opening connection
226 Transfer complete
262144 bytes received in 9.22 seconds (28 Kbytes/s)
ftp> quit
221 Goodbye
%
To send a text file after this binary (image) file transfer is complete, you must first
enter ascii to reset the transfer mode to ASCII (text).
Multiple Files

Some versions of FTP let you enter one command (either mput or mget) plus wild-
card characters to transfer multiple files sequentially.

When you use wildcards in FTP get commands, you must enclose the filename in
quotation marks. For example, enter get "*.1image". Do not use quotation marks
with put commands.

WARNING: If you transfer multiple binary (image) files using a UNIX host, note that
there is a bug in the mget command as implemented on some systems (especially
4.2 BSD UNIX systems). When used in binary mode, the mget command adds a car-
riage return to filenames as they are transferred. The files themselves are not
affected. Use a UNIX utility to remove the carriage return from the filename. When
used to transfer multiple ASCII (text) files, the mget command causes no problems.
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MacBinary Files
You may occasionally need to transfer Macintosh-only files (such as applications
and most data files) to a non-Macintosh host, then download them later without
losing any Macintosh-specific data (such as icons and creation dates).

Follow these instructions, and remember that the MacBinary transfer protocol is
available only when FTP is in binary mode:

1. Select MacBinary Enabled from the File menu. When MacBinary is enabled, all get
and put commands transfer Macintosh files in MacBinary format.

You can alternately enable and disable MacBinary by selecting this option from
the File menu. A checkmark (v’) appears next to the command when it is
enabled.

2. Enter either binary or bin at the FTP prompt to set the file transfer mode to
binary.

NOTE: If you are writing host-based scripts to download from or upload to a Macin-
tosh in MacBinary mode, enter quote MACB ENABLE to enable MacBinary mode and
quote MACB DISABLE to disable MacBinary mode.
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5 Tektronix Graphics

This chapter describes the Tektronix 4014 and 4105 graphics emulation capabili-
ties of NCSA Telnet for the Macintosh and explains how to use these graphics win-
dows. Tektronix vector graphics use mathematical descriptions to create images
primarily as collections of lines.

Tektronix 4014 and 4105 Emulation

NCSA Telnet can emulate a number of graphical capabilities of Tektronix 4014 and
4105 terminals, including text modes, text sizing, zoom, and pan. Using Tektronix
graphics with NCSA Telnet depends on host programs that can produce graphical
images. When the host programs run and produce Tektronix 4014 or 4105 graphics
commands, NCSA Telnet automatically switches to graphics mode, opens a graph-
ics window, and does the drawing.

Starting a Tektronix Emulation

How you set the TEK options in the Session Configuration Record dialog box deter-
mines the type of Tektronix emulation, if any, for a given session. In the dialog box
you can click on one of three TEK options: Inhibit, 4014, or 4105.

Hostname |bnnham.zeppeh’n.cnm |
Fort
TEK () Inhibit W ELIE! ® 4105
Paste Method (@) Quick i) Elack
Delete Sends ) Delete i) Backspace

|:| Forcesave
|:| Berkeley 4.3 CR rode

E<] anew tinemode Interrupt I:I
E TEK page clears screen

[ Hatt duplex Suzpend
|:| Show Tow lewel errors Pesume
|:| Authenticate

|:| Encrypt

|:| Local Echo

Termminal Translation Table

A host program generates the Tektronix clear-screen command sequence (ESC, FF)
over an open connection. When NCSA Telnet receives this command, a graphics
window opens. All graphical output from the session is redirected into this window
until you either close the window or send the TEK end command.



Tektronix-Related Commands in the Session Menu

Two Tektronix-related commands appear in NCSA Telnet’s Session menu:

Backspace
« Delete

Local Echo
« Wrap Mode
EMACS arrow mapping
+Map PqUp/PgDown/Home/End
Translation [ 2
« Clear Screen Saves Lines
Reset Terminal
Jump Scroll 3#d
TEK Page...
TEK form feed clears screen

Set Screen Size...

Setup Keys... ®S
Font [ 2
Size [ 2
Color...

Capture 5ession to File #EK

TEK Page... This command provides a quick way to create a Tektronix Emulation win-
dow without intervention from host software. Instead of waiting for
NCSA Telnet to receive the clear-screen command sequence from the
host, you can create the window immediately by selecting TEK Page....

Just as you would use the PAGE key on a Tektronix keyboard to clear
the window for the current session, you can select TEK Page... to clear a
graphics window. If a Tektronix window is not open, selecting this
command creates a cleared graphics window.

TEK form feed clears screen When you select this command, NCSA Telnet’s Tektronix emulation
clears the current Tek window any time it receives a Tektronix clear-
screen command sequence. If this command is not selected, NCSA Tel-
net creates a new window for the new Tektronix image. The session’s
name and time automatically become the name of each new window.

Tektronix Graphics Windows

NCSA Telnet lets you detach, delete, zoom and unzoom, copy, resize, and print
graphics windows.

Detaching
Detach a graphics window by clicking on the text window for that graphic’s connec-
tion. If you hold down the OPTION key, you can click on a window without detach-
ing the corresponding graphics window. The title of a detached window no longer
contains the bullet (-) that identifies it as the active output window.

The window can also be detached by host software. When the CAN character (dec
24) is received, the terminal is reset to VT screen emulation.
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Deleting

Delete a graphics window by clicking on the close box in the upper-left corner of
the window’s title bar.

Zooming and Unzooming
To magnify (zoom in on) a portion of a drawing in a graphics window, drag a selec-
tion rectangle around the area you want to view more closely. When you release the
mouse button, the selected section of the drawing expands to fill the entire win-

dow. To prevent distortion or stretching of the TEK image, the magnified selection

always maintains the same aspect ratio as the TEK window.

To unzoom and see the entire drawing, double-click anywhere in the window.

You can copy and print the contents of both zoomed or unzoomed windows. When
you copy or print a zoomed window, only the visible portion of the window is cop-

ied or printed.

This screen shows a normal-size Tektronix Emulation window with zero magnification:

newton 2:09 PM

Hardhare Copab Il 1 v
Tawk: — Corrant Orlmre

Pareloe Ll rabd sn

CI_z000
Pl oty S i ks e

3 weorEy . #wop | [EEsEss e =
DA LI 1 —_———————
oI+ oI+ Ravlow Llrewsldtha

b I o+ =g I+ = g

E + %o fE 4 E B 1

r E o B E I U ]

Pavlos Hurdvors Tt

Lare - LarlalF leed
Cardmr budelFlad

Fipht Jdusklfled

-
Size 2
Slee 2

Size 4
Siza &

Size &
Slze 7
Fork 2
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This screen shows a portion of the same drawing in zoomed magnification:

S [=—————— newton 2:05 P™ §—|

re Lapab il ikies [+

Lurrernt Driver

30010 —

Copying
To copy the contents of a graphics window onto the Macintosh clipboard, activate
the window by clicking on it, then choose Copy from the Edit menu. Now you can
paste the graphic into another Macintosh application.

Resizing
To resize a graphics window, click and drag the lower-right corner of the window.
The Tektronix Emulation window does not have a grow icon.

Printing

To print the contents of a graphics window on a local printer or on a remote printer
on the AppleTalk network, first activate the window by clicking on it and then
choose Print Selection from the File menu.

NCSA Telnet centers and scales all graphics to fit the page. To achieve the best pos-
sible resolution on a LaserWriter, in the Page Setup dialog box enter 25 as the Reduce
or Enlarge option percentage, as shown in the sample below.

LaserlWriter Page Setup 7.2

Faper: & US Letter A4 Letter _
C1US Legal () BS Letter |_Tabloid A

Reduce or Printer Effects:
-25 g
Enlarge: ] Font Substitution?

Orientation (<] Text Smoothing?
: (4 Graphics Smoothing?
[ Faster Bitmap Printing?

The 25% setting makes the lines thinner but does not change the size of the image.

For more information about the Page Setup dialog box, refer to your Macintosh
user’s guide.
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6 Interactive Color Raster Graphics

Raster graphics generate color images stored as a collection of pixels (dots)
arranged in rows and columns. This chapter introduces the Interactive Color Raster
protocol and describes how to use it to write programs that display color graphics
with NCSA Telnet for the Macintosh. The chapter concludes with a sample C pro-
gram you can use as a template for designing programs that use the ICR protocol.

Using the ICR Protocol

Interactive Color Raster (ICR) is a protocol for displaying raster graphics on your
workstation screen. The ICR protocol controls its own windows through NCSA Tel-
net and shares characteristics of the Tektronix graphics terminal emulation proto-
col. One such shared characteristic is that escape sequences control the display.

To run ICR graphics you must have:

a 256-color Macintosh computer
an ICR program that runs on your remote host

You can use ICR to write mainframe programs that display color images (in the full
range of 256 colors) in their own windows on your Macintosh screen.

Your ICR program must include all commands needed to emulate ICR graphics. To
create an ICR program, work from the protocol description contained later in this
chapter (“Creating an ICR Program” on page 6-2) and from the sample program
(“Sample ICR Program in C” on page 6-6).

Starting and Quitting ICR Graphics Emulation
When the protocol’s command for creating a window arrives from a remote host,
NCSA Telnet creates a Macintosh window for it. All human-readable text is sent to
the session window, while all graphics commands are sent to the proper graphics
window.

The ICR program on the remote computer can also remove the window. If it does
not, you can delete a graphics window by clicking in the close box in the upper-left
corner of the window’s title bar. If you close an NCSA Telnet connection while some
windows remain open, the windows close automatically.

Allocating Memonry

Raster graphics windows require a lot of memory—one byte for each pixel in each
graphics window on the screen. If insufficient memory remains to open a new win-
dow, NCSA Telnet displays an alert box and does not create the window.

If you are using MultiFinder, you can increase NCSA Telnet’s allocated memory size
so that you are less likely to run out of memory. For example, if you need space for
two image windows and each is 256 pixels x 256 pixels, increase NCSA Telnet’s
allocated memory size by 128 K (256 bytes x 256 bytes, or 64K, for each window).



Copying an ICR Graphics Window

You can copy the contents of an ICR window to the Macintosh clipboard, then paste
it into a program capable of pasting color images.

To copy the contents of a graphics window:
1. Click in the graphics window to bring it to the front.
2. Choose Copy from the Edit menu.

Now you can paste the graphic into another Macintosh application.

System Color Problems

Image windows use the display colors that are available on your Macintosh screen.
When you close graphics windows, the system does not always restore the color
environment to its original state, which causes incorrect colors in other windows.
We are working to minimize the effects of NCSA Telnet and ICR graphics on your
system’s color table.

Pressing CONTROL-C (or using other methods to interrupt ICR commands) can
make NCSA Telnet appear to lock up. (See also Send "Are You There?" and Send "Inter-
rupt Process” under “Telnet Commands” on page 3-3.) When this occurs, either
press RETURN several times or enter commands until the session window resumes
activity. It may be useful to remember that each time you issue a drawing com-
mand NCSA Telnet expects an influx of often hundreds of bytes of image data to
finish drawing the current line.

Creating an ICR Program

You must write a program that issues graphics commands to NCSA Telnet. NCSA
Telnet follows your programs’ directions to receive graphics commands, interpret
them, create or destroy windows, set the color environment, and display raster

graphics.

Escape Sequence
Begin all ICR graphics sequence commands with the escape sequence ESCA (escape,
caret). This escape sequence ensures that NCSA Telnet can distinguish between
regular text and ICR graphics.

ICR Commands

Each ICR command appears in the following form:

ESCAX; parameters A data

where:
Xis one of the command characters (W, D, M, R, P, or I) described in “ICR Com-
mand Parameters” on page 6-3.
A is the caret character (ASCII 94).
Parameters is one or more of the options of X described in “ICR Command
Parameters” on page 6-3. Parameters are always printable ASCII characters and
are delimited by commas. If your program omits parameters, NCSA Telnet sup-
plies default values.
The command is terminated with a caret (A).
Each command can be followed by a data stream (data). If a command requires
a data stream, the stream follows the command.
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ICR Command Parameters

Command characters and their parameters are described below:

Option
Command Parameters Description
W Teft; top; Creates a window at the specified location on
height; width; the screen. 0, 0 is the upper-left corner of
display; the screen.
windowname e The left, top, width, and height integers
identify specific locations on the screen:
Lop
|
S[e——t————puhp —e—————————1115
L <
¥
left >

« height
| |
A
]
>
=) [
width
Integer Definition
left the pixel value of the x (horizontal) location of the upper-left cor-
ner of the graphics window
top the pixel value of the y (vertical) location of the upp-erleft corner
of the graphics window
height the number of pixels in the vertical height of the graphics window
width the number of pixels in the horizontal width of the graphics win-

dow

e The display integer identifies the hardware
screen number (for machines with multiple
screens). This parameter is not applicable
to Macintosh systems.

e Windowname 1is the unique name assigned to a
window by the W command. The assigned
windowname distinguishes between multiple
windows. It is used by all other commands to

specify that window.

D windowname Destroys a window by physically removing it
from the screen and memory.

o Windowname 1is the unique name assigned
to a window by the W command.

M start; length; Loads into the graphics window a color map
count; windowname palette (of up to 256 colors) or portion of
one. NCSA Telnet assumes that each palette

entry is 3 bytes in the order R, G, and B.
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The default palette is a straight gray-scale
ramp, where 0 = black and 255 = white. (See
“Color Maps” on page 6-5.)

e The start integer identifies the first entry
to change.

e The length integer indicates the number of
entries to change.

e« The count integer indicates the total number
of bytes in the data portion. Follow the count
integer with the command’s data stream.

e Windowname 1is the unique name assigned
to a window created by the W command.

R X; y; expand Indicates the data that follow are run-Tength
Tength; encoded. (See “Run-Length Encoding” on page 6-5.)

« The x and y integers identify the point
where the raster line starts and data
follow for length bytes of encoded data.

e« The expand integer indicates how many
times each dimension is to be expanded on
your local screen. For example, an expand
value of 2 makes the picture 4 times larger.

e The length integer indicates the encoded
Tength (in bytes) of the data.

e Windowname 1is the unique name assigned
to a window created by the W command.

P X; y; expand; Indicates the data that follow are pixel data.
Tength; « The x and y integers identify the point
windowname where the raster Tine starts and data

follow for length bytes of pixel data.
e The expand integer indicates the number
of times each dimension is to be expanded on
your local screen. For example, an expand
value of 2 makes the picture 4 times larger.
e The length integer indicates the encoded
length (in bytes) of the data.
e Windowname 1is the unique name assigned
to a window created by the W command.

I X; y; expand; Indicates the data that follow are encoded
Tength; with the IMCOMP compression scheme (4:1
windowname compression). You must use the M command

before the picture displayed with the I
command appears correctly.
e The x integer indicates the number of
pixels per line. One I call represents 4
Tines of data. Since IMCOMP is a 4 x 4
square compression scheme, each line of
data appears as 4 lines of pixels on the
screen.
e« The y integer is required to increment
by fours: 0, 4, 8, 12, 16, etc.
e The length integer indicates the Tength
(in bytes) of the data. Length should be the
same as the number of pixels to be displayed.
o Windowname 1is the unique name assigned
to a window created by the W command.
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Color Maps

ASCII Encoding

Use the M command to manipulate the color table for your local display. The format
for color map data is a series of color-map entries. Each color-map entry is three
bytes: one R (red), one G (green), and one B (blue). For example, to set entries 3
through 7 of the color table, you could use the following M command:

ESCAM;3;4;12;windARGBRGBRGBRGB

where RGBRGBRGBRGRB is the list of byte values for the new entries. The actual data
transmitted over the line must still be ASCII encoded, but the data start out in this
form.

NOTE: The count field is always three times the length value. In the example above,
the count field is 12 and the length value is 4.

NCSA Telnet assumes that all parameter values (except ESC) are printable ASCIL.
This means that the parameters require no special encoding, but data values need
help. ESC is an allowable exception on most logon data streams.

Your ICR program must encode 8-bit data values into printable ASCII for transmis-
sion. When possible, the values that fall in the printable ASCII range are passed
untouched, and all values outside that range are encoded as two bytes.

Use the following encoding for all characters 0-255:
Input realchar
Transmission specialchar followed by transchar

Encoding specialchar = realchar div 64 + 123
transchar = realchar mod 64 + 32

Decoding: realchar = (specialchar - 123)*64 + (transchar - 32)

These four codes encode data values in printable ASCII character for all characters
0-255, as shown below:

Special Range
123 0-63
124 64-127
125 128-191
126 192-255

Because all encoded characters are preceded by a character in the 123-126 range,
you can send all regular characters that are 32-122 (inclusive) without encoding.

WARNING: Because the CTSS operating system trims trailing spaces, you should
avoid the values 0, 32, 128, and 192 because they code to special space.

NOTE: In the specifications, all data lengths and counts refer to the protocol data,
not to the ASCII-encoded data. The length fields for the R, P, and M commands all
reflect the data length on the originating machine before encoding.

Run-Length Encoding

Data for the run-length encoded (RLE) line are first run-length compressed and
then ASCII encoded. The deciphering process first decodes ASCII to binary and
then decodes the run-length binary data.
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Using all 8 bits of the byte stream representing the pixels in a given RLE line, start
with the control character. The lower seven bits of the byte are represented by n.
The high bit represents whether the n characters that follow are reproduced
exactly (high bit = 0) or whether the single character that follows is reproduced n
times (high bit = 1).

Input 1 1 1 1 23 23 23 234 112 33 44 55 42 42 42 42

Tokenized (128+4) 1 (128+3) 23 (5) 234 112 33 44 55 (128+4) 42

Alternate count, data, count, data
After coding in this tokenized form, you know the data length for the R command.
(The length is 12 in the example above). Even though ASCII encoding occurs after
this step, use the length value from this step.

ASCIT result 125 36 123 33 125 35 123 55 123 37 126 74 112 33 44 55 125 36 42

Sample ICR Programin G

The sample C program shown below is included on the distribution disk. If you are
running an active ICR-equipped NCSA Telnet, this program produces a test pattern
on your screen. If you do not have ICR, this program produces thousands of
encoded characters on your screen.

/* icrtest

* Produces a test pattern on an ICR compatible display. Demonstrates and provides
* example code for writing ICR programs.

National Center for Supercomputing Applications

* University of Il1linois, Urbana-Champaign

* by Tim Krauskopf
* This program is in the public domain.
s‘:/

#include <stdio.h>

int

xdim=0,ydim=0; /* size of image on disk */
char

*malloc(),

*testimage,

rgb[768]; /* storage for a palette */

main(argc,argv)

int argc;
char *argv[];
{

register int 1i,j;
register char *p;

puts("Creating test pattern");

xdim 150;
ydim = 100;

if (NULL == (testimage = malloc(xdim*ydim)))
exit(l);
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/7':

*

*/

}

p = testimage;
for (i=0; i<ydim; i++)
for (3j=0; j<xdim; j++) {
*p++ = 50 + (((0 & OxFFFFFFF8) * (J & 7))>>2);
}
puts("Displaying test pattern with the Interactive Color Raster protocol");
rimage(0); /* display remote image with [palette] */
/*****************************************************************************/
rimage

/7':

*

*

*/

Make the test image in a strange pattern.

Remote display of the image using the ICR.
Just print the codes to stdout using the protocol.

rimage(usepal)

/*

*

*/

int usepal;

{

int 1i,j,newxsize;

char *space,*thisline,*thischar;
register unsigned char c;

Open the window with the W command.

(void)printf("\033AW;%d;%d;%d;%d;0;test windowA",0,0,xdim,ydim);

/*

*

*/

If a palette should be used, send it with the M command.

if (usepal) {
(void)printf("\033AM;0;256;768;test windowA");

thischar = rgb;
for (j=0; j<768; j++) {
c = *thischar++;
if (c > 31 && c < 123) {
putchar(c);

}
else {
putchar((c>>6)+123);
putchar((c & 0x3f) + 32);
}
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/7':
* Send the data for the image with RLE encoding for efficiency.
* Encode each 1line and send it.
*/

space = malloc(ydim+100);

thisline = testimage;
for (i = 0; i < ydim; i++) {
newxsize = rleit(thisline,space,xdim);
thisTine += xdim; /* increment to next Tline */

(void)printf("\033AR;0;%d;%d;%d;test windowA",i,1,newxsize);

thischar = space;
for (j = 0; j < newxsize; j++) {

/***********************************************************************/

/* Encoding of bytes:

bl

* 123 precedes #'s 0-63

* 124 precedes #'s 64-127

* 125 precedes #'s 128-191

* 126 precedes #'s 192-255

overall: realchar = (specialchar - 123)%64 + (char-32)
specialchar = r div 64 + 123

* char = r mod 64 + 32

c = *thischar++; /* get byte to send */

if (c > 31 && c < 123) {
putchar(c);

}

else {
putchar((c>>6)+123);
putchar((c & 0x3f) + 32);

}

free(space);

/¥ rleit
* Compress the data to go out with a simple run-length encoded scheme.

*

*/
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rleit(buf,bufto,len)

int len;
char *buf,*bufto;
{
register char *p,*q,*cfoll,*clead;
char *begp;
int i;
p = buf;
cfoll = bufto; /* place to copy to */
clead = cfoll + 1;
begp = p;
while (len > 0) { /* encode stuff until gone */
qg=p+1;
i = Ten-1;
while (¥*p == *q && i+120 > len && i) {
q++;
i--;
}
if (g>p + 2) { /* three in a row */
if (p > begp) {
*cfoll = p - begp;
cfoll = clead;
}
*cfoll++ = 128 | (g-p); /* len of seq */
*cfoll++ = *p; /* char of seq */
len -= g-p; /* subtract len of seq */
p=4q;
clead = cfoll+1;
begp = p;
}
else {
*clead++ = *p++; /* copy one char */
Ten--;
if (p > begp + 120) {
*cfoll = p - begp;
cfoll = clead++;
begp = p;
}
}
}
/:':
* 411 in Tast bytecount
s‘:/
if (p > begp)
*cfoll = 128 | (p - begp);
else
clead--; /* don't need count position */
return((int) (clead - bufto)); /* how many stored as encoded */
}
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A Troubleshooting

This appendix describes some common error messages reported by NCSA Telnet
for the Macintosh. Causes and solutions are also included.

New Error Messages

A new error message system has been implemented in Version 2.6 of NCSA Telnet.
The dialog boxes announcing most error conditions are now more verbose. A few
error messages still use the former error message system.

Each new-style error box includes two fields: Internal error # and MacOS error #. When
you report a problem or possible bug to NCSA, please include these numbers. They
help track down the cause of the problem you are experiencing. If these numbers
are zero, NCSA Telnet is unable to provide more detailed information than the mes-
sage given.

Nonfatal Errors

A nonfatal error is a condition that NCSA Telnet can remedy. You see an error box
similar to the following:

That operation cannot be completed
because the set contains an invalid
keyword.

Internal error #0

Macs error #0

Nonfatal errors most often occur when an action you request fails. The following
conditions can currently cause nonfatal errors:

Insufficient memory
Corrupted set file
Inability to open or create a capture file



Semifatal Errors

A semifatal erroris a condition that NCSA Telnet can attempt to remedy. If the rem-
edy fails, NCSA Telnet must quit. You see an error box similar to the following:

The preferences file appears to be
corrupted. | can attempt to correct the
problem.

Internal error #100

Maci$ error #-192

Selecting Quit causes NCSA Telnet to quit immediately without attampting any
recovery. Selecting Repair instructs NCSA Telnet to attempt to repair the damage.
However, Repair does not always work and may lead to a fatal error condition.

Only one condition—a corrupted Preferences file—currently causes semifatal errors.

Fatal Errors
A fatal error is a condition from which NCSA Telnet cannot recover. NCSA Telnet
must quit immediately. You see an error box similar to the following:
0 Telnet requires at least System version 6.0.
Internal error #0
Mac0$ error #0
The only available option is Quit.
The following conditions can currently cause fatal errors:
No HFS file system
System version not 6.0 or higher
Fewer than 128 K ROMs
Inability to open MacTCP
Inability to create preferences file
Corrupted NCSA Telnet application file (resources missing)
Inability to repair a corrupted preferences file
Old Error Messages

Not all error messages in NCSA Telnet Version 2.6 have been converted to the new
error-reporting system. These are some old-style error messages, what they mean,
and what you can do:
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Couldn’t get translation resource for national character set

Translation resource is corrupted

Error deleting old file

Error in Sfwrite

Disk Full Error

Host or gateway not responding

A resource is missing from the NCSA Telnet applica-
tion. Replace your copy of NCSA Telnet from a backup
or download a new copy.

A resource is missing from the NCSA Telnet applica-
tion. Replace your copy of NCSA Telnet from a backup
or download a new copy.

An error occurred during a file transfer when the FTP
server attempted to overwrite a file on the local disk.

An error occurred during a file transfer when the FTP
server attempted to write to the local disk.

The FTP server ran out of disk space when it tried to
transfer a file to the local disk.

This error used to be a catchall for nearly all errors
related to connecting to a host. Now this error mes-
sage is produced only if the host you are trying to
contact does not respond or if a host you are con-
nected to stops responding. Possible causes include:
you accidentally unplug your machine from the net-
work, the remote host loses power or its network con-
nection, or your local gateway or Internet connection
goes down.
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VT Emulation

This appendix lists features and modes of the VT standard that are not supported
by NCSA Telnet for the Macintosh, key mapping to emulate VT keys, and the escape
codes sent by NCSA Telnet for certain codes in various emulation modes.

This appendix is intended as a reference to NCSA Telnet’s implementation of VT
emulation, not as the definitive source for information regarding the VT series of
terminals.

VT Compatibility

NCSA Telnet does not support:

double-height or double-width characters
the VT52 mode

Key Mapping

NCSA Telnet does not emulate the following VT200 keys: F1, F2, F3, F4, and F5.

NCSA Telnet maps F6 through F20 on the VT200 keyboard to F1 through F15 on
the Apple Extended Keyboard.

NCSA Telnet maps PF1 through PF4 on the VT200 keyboard to the top row of keys
on the Apple numeric keypad (CLEAR, =, /, *).

Escape Codes

Editing Keys

NCAS Telnet always sends the CSI and SS3 control characters using their seven-bit
extensions. Therefore, substitute ESC [ (1B 5B) for CSI and ESC O (1B 4F) for SS3 in
the following tables.

The keycode tables below follow the divisions used in the VT200 manual.

VT Key Name VT200 Mode VT100 Mode
HELP (find) 9B 31 7E
CSI 1 ~
HOME (Insert Here) 9B 32 7E NCSA Telnet sends the VT220
CSI 2 ~ codes for these keys while
PAGEUP (Remove) 9B 33 7E in VT100 mode, even though
CST 3 ~ these keys did not exist
DEL (Select) 9B 34 7E on the VT100.
CSI 4 ~
END (Prev Screen) 9B 35 7E
CSI 5 ~

PAGEDOWN (Next Screen) 9B 36 7E
CSI 6 ~



Cursor Control Keys

Cursor control keys are the same for VT200 and VT100 emulation.

Key Reset Normal Mode Set Application Mode
<- Cursor Key Mode
UpArrow 9B 41 8F 41
CSI A SS3 A
DownArrow 9B 42 8F 42
CSI B SS3 B
RightArrow 9B 43 8F 43
CSI C SS3 C
LeftArrow 9B 44 8F 44
CSI D SS3 D
Auxiliary Keypad Godes
Auxiliary keypad codes are the same for VI200 and VT100 emulation.
Key Keypad Numeric Mode Keypad Application Mode
0 30 8F 70
0 SS3 p
1 31 8F 71
1 SS3 ¢
2 32 8F 72
2 SS3 r
3 33 8F 73
3 SS3 s
4 34 8F 74
4 SS3 t
5 35 8F 75
5 SS3 u
6 36 8F 76
6 SS3 v
7 37 8F 77
7 SS3 w
8 38 8F 78
8 SS3 x
9 39 8F 79
9 SS3 vy
- 2D 8F 6D
- SS3 m
+ () 2C 8F 6C
) SS3 1
2E 8F 6E
. SS3 n
Enter ww 8F 4D
o SS3 M
Clear (PFD) 8F 50 8F 50
SS3 P SS3 P
= (PF2) 8F 51 8F 51
SS3 Q SS3 Q
/ (PF3) 8F 52 8F 52
SS3 R SS3 R
* (PF4) 8F 53 8F 53
SS3 Q SS3 Q
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Top-Row Function Keys
VT

F1

F2

F3

F4

F5

F6

F7

F8

F9

F10

F11

F12

F13

F14

F15

Key Name
(F6)

(F7)

(F&)

(F9

(F10)

(F11)

(F12)

(F13)

(F14)
(F15/Help)
(F16/Do)
(F17)
(F18)
(F19)

(F20)

V1200
9B 31
CSI1
9B 31
CSI1
9B 31
CSI1
9B 32
CSI 2
9B 32
CSI 2
9B 32
CSI 2
9B 32
CSI 2
9B 32
CSI 2
9B 32
CSI 2
9B 32
CSI 2
9B 32
CSI 2
9B 33
CSI 3
9B 33
CSI 3
9B 33
CSI 3
9B 33
CST 3

Mode Code
37 7E
7 ~
38 7E
8 ~
39 7E
9 ~
30 7E
0 ~
31 7E
1 ~
33 7E
3 ~
34 7E
4 ~
35 7E
5 ~
36 7E
6 ~
38 7E
8 ~
39 7E
9 ~
31 7E
1 ~
32 7E
2 ~
33 7E
3 ~
34 7E
4 ~

VT100 Mode Code

NCSA Telnet sends the VT220
codes for these keys while

in VT100 mode, even though

these keys did not exist

on the VT100.

VT Emulation (] B-3



C Obtaining NCSA Software

You can obtain NCSA software and manuals via an anonymous FTP server, an
archive server, or U.S. mail.

Anonymous FTP Server

If you are connected to the Internet, you can download NCSA Telnet software and
manual at no charge from NCSA’s anonymous File Transfer Protocol (FTP) server.
Follow the steps enumerated below. If you have any questions regarding the con-
nection or procedure, consult your local system administrator or network expert.

1. Log on to a host at your site that is connected to the Internet and is running
software supporting the FTP command.

2. Invoke FTP (on most systems) by entering the Internet address of the server:
% ftp ftp.ncsa.uiuc.edu
Log on by entering anonymous for the name.

4. Enter your local login name and address (e.g., smith@ncsa.uiuc.edu) for the
password.

5. Enter get README.FIRST to transfer the instructions file (in ASCII) to your
local host.

6. Enter quit to exit FTP and return to your local host.

7. Review the README. FIRST file for complete instructions concerning the orga-
nization of the FTP directories and the procedures you should follow to down-
load the README files specific to the application you want.

Your logon session should resemble the following sample, where the remote user’s
name is smith@ncsa.uiuc.edu and user entries are indicated in boldface type:

% ftp ftp.ncsa.uiuc.edu

Connected to zaphod.

220 zaphod FTP server (Version 6.23 Thu Apr 8 06:37:40 CDT 1994) ready.
Name (ftp.ncsa.uiuc.edu: smith): anonymous

331 Guest login ok, send ident as password.

Password: smith@ncsa.uiuc.edu

230 Guest login ok, access restrictions apply.

ftp> get README.FIRST

200 PORT command successful.

150 Opening ASCII mode data connection for README.FIRST (10283 bytes).
226 Transfer complete.

local: README.FIRST remote: README.FIRST

11066 bytes received in .34 seconds (32 Kbytes/s)

ftp> quit

221 Goodbye.

%

The README . FIRST file instructs you to copy the NCSA Telnet Mac README file to
your directory and to read it before proceeding. Your FTP session should resemble
the following:



ftp> cd Mac/Telnet

250 CWD command successful.

ftp> get README

200 PORT command successful.

150 Opening ASCII mode data connection for README (10283 bytes)
226 Transfer complete.

Tocal: README remote: README

2080 bytes received in .14 seconds (15 Kbytes/s)

ftp> quit

221 Goodbye.

%

The README file explains how to copy contents of the NCSA Telnet Macintosh direc-

tory to your home directory via remote logon or anonymous FTP. The precise file
transfer procedure depends upon the operating system you use.

Archive Server

Email a request to archive-server@ncsa.uiuc.edu.

Include the word help in the subject or message line.

Press RETURN.

Send another email request to archive-server@ncsa.uiuc.edu.
Include the word index in the subject or message line.

Press RETURN.

o vk Wy =

If you use the UNIX mail system, your logon session should resemble the following:

% mail archive-server@ncsa.uiuc.edu

Subject: help

EOT

Null message body; hope that's ok

% mail archive-server@ncsa.uiuc.edu

Subject: -index

EOT

Null message body; hope that's ok

Information you receive from the help and index commands gives you further

instructions for obtaining NCSA software. This controlled-access server emails the
distribution to you one segment at a time.

NCSA Telnet software and manual are available for purchase through the NCSA
Technical Resources Catalog. All orders must be prepaid. To obtain a copy of the
catalog, contact NCSA Orders by electronic mail at orders @ncsa.uiuc.edu, by
phone at (217) 244-4130, or by U.S. mail at:

NCSA Orders

152 Computing Applications Building
605 East Springfield Avenue
Champaign, IL 61820-5518
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Index

NOTE: Page numbers in italics refer to figures.
Icons are grouped under the entry “icons.” Key-
board commands indicated in the text by symbols
are grouped under the entry “keyboard commands.”
Symbols are grouped under the entry “symbols.”

A

Abort Output command, 3-4
active session, 3-1, 3-2
Alias option, 2-6
aliases, 1-3, 2-6, 3-2, 4-2
Allow linemode option, 2-7, 2-9
anonymous FTP server, NCSA software available via,
inside title page, C-1 to C-2
Answerback Message option, 2-5
Apple Desktop Bus keyboard, emulating VT
keyboard, 1-4
Apple Extended Keyboard, B-1
AppleTalk network, 5-4
archive server, NCSA software available via, C-1 to
C-2
Are You There command, 3-4
ARPA standard telnet, v
arrow keys
and cursor positioning with mouse, 3-1
in EMACS editor, 2-4, 2-9, 3-1
ascii command, 4-6, 4-7, 4-8
ASCII files
definition of, 4-1
for ICR graphics, 6-5
transferring files as, 4-7, 4-8
Authenticate box
in Session Configuration Record dialog box,
2-7,3-6 to 3-7
Authenticate option
in Open Connection dialog box, 1-2, 3-6 to 3-7
authentication, 1-2, 2-7, 3-5, 3-6 to 3-7
auxiliary keypad codes, B-2

background

applications running in, 2-2

file transfers processed in, 4-2
backquote ("), as ESCape character, 1-4, 2-1
backslash (, for macros, 2-15 to 2-16
Backspace command, 1-3, 2-9
BACKSPACE/DELETE key, 1-3, 1-4, 2-7, 2-9, 2-16

Berkeley 4.3 CR Mode option, 2-7, 2-12, 4-6
binary (bin) command, 4-6, 4-7, 4-9
binary files, 4-1, 4-7, 4-8
Binary Filetype and Creator options, 4-4
Blink Cursor option, 2-2
Blinking background option
in Color Selection dialog box, 2-13
in Terminal Configuration Record dialog box,
2-5
Blinking foreground option, in Terminal
Configuration Record dialog box, 2-5
Blinking Text option, in Color Selection dialog box,
2-13
Block option
in Global Preferences dialog box, 2-2
in Session Configuration Records dialog box,
2-6
bugs, corrected from Version 2.5, vi. See also error
messages; warnings

C

C programming language, 2-15, 6-6 to 6-9
C shell, for setting UNIX-compatible terminal type,
1-4
“Can't get translation resource for national charac-
ter set” error message, A-3
Capture File Creator option, 2-2
capture files, saving or creating, A-1
Capture Session to File option, 2-13
cd command, 4-6, 4-7
Change Default Directory option, 4-5
Change option, in Preferences dialog boxes, 2-3, 2-4,
2-6, 4-5
Change Password option, 3-6
Change Window Title... command, 3-3
checkmark (+), 3-2, 4-9
circle (~), 3-2
Clear Screen Saves Lines command, 2-10
cleared screens, 2-5, 5-1, 5-2
client/server model, definition of, 4-1
clipboard. See Macintosh clipboard
Close command, 1-5, 2-2
Close Connection dialog box, 1-5, 1-6
CNTL-COMND is EMACS meta option, 2-5
color
ICR color maps, 6-5
palette of, 6-3 to 6-4



setting screen colors, 2-5, 2-13
system color problems, 6-2
Color... option, 2-13
Color Selection dialog box, 2-13
Color Wheel dialog box, 2-5, 2-13
Command Keys option, 2-1
config.tel file, external configuration files
discontinued in Version 2.6, vi, 2-3
configuration records
changing after session connection, 2-9 to 2-13
customizing, 2-1 to 2-16
defaults, 2-3
editing of session configuration record, 2-3,
2-5to 2-8
editing of terminal configuration records, 2-3,
2-4 to 2-5, 2-8
Connect option, 1-2
Connection dialog box. See Open Connection dialog
box
Connection Status dialog box, 3-3
Connection window, 1-3, 3-7
Connections menu, 1-3, 3-1, 3-2 to 3-3
connections to a host
aborting attempts at, 3-3
alternative, 1-3
closing, 1-5, 1-6, 4-7, 6-1
confirming terminal type in use, 2-5
emulating VT terminal keyboard, 1-4
error messages regarding, 2-2
as FTP client, 1-2
and FTP file transfers, 4-6, 4-8
logging on, 1-3
multiple, 1-2, 3-1 to 3-2
opening, 1-2 to 1-3, 3-1
port for, 2-6, 3-2, 4-2
problems with, A-3
response time of, 1-3
setting BACKSPACE/DELETE key, 1-3, 2-7, 2-9
setting VT terminal type, 1-3 to 1-4
specifying host and session name for, 1-2, 1-3,
2-3, 2-6, 3-2
suspension of, 3-4 to 3-5
verification of, 3-4
CONTROL key, 2-1
CONTROL-C (Interrupt) command, 2-7, 2-16, 3-4,
6-2
CONTROL-COMMAND-anykey, 2-5
CONTROL-D, macro for, 2-16
CONTROL-E, macro for, 2-16
CONTROL-H (BACKSPACE), macro for, 2-16
CONTROL-Q (Resume) command, 2-8
CONTROL-S (Suspend) command, 2-8
Copy command, 1-5, 5-4, 6-2
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Copy Table command, 1-5, 2-2
Copy Table threshold option, 1-5, 2-2
copying
in Edit menu, 1-5
of ICR graphics windows, 6-2
of tables, 1-5, 2-2
of Tektronix graphics windows, 5-4
copyright, inside title page
Courier font, 2-12
creator type, 2-2
.cshrc file, 2-12
CTSS operating system, 6-5
cursor
blinking, block, underlined, or vertical options
for, 2-2
I-beam, 4-6
positioning of, with mouse, 3-1
and VT escape keys, B-2
customization, of NCSA Telnet for the Macintosh
configuration, 2-1 to 2-16

DEC All-in-One, 2-7
Default Directory option, 4-5
defaults
of BACKSPACE/DELETE key codes, 1-3
of configuration records, 2-3
of directories, 4-6, 4-7
for file transfers, 4-7
for interrupt, suspend, or resume telnet func-
tions, 2-7
resetting Macbinary files to, 4-4
of session configuration record, 2-3, 2-6, 3-7
of tabs, 2-10
of terminal configuration record, 2-3, 2-4
of terminal type, 2-5
of VT terminal emulation settings, 2-11
for word wrapping, 2-4
delete codes, 1-3,1-4, 2-7
Delete command, 1-3, 2-9
DELETE key, 1-3, 1-4, 2-7, 2-9
Delete Sends option, 2-7
deletion, of graphics windows, 5-3, 6-1
DES encryption, 3-5
detaching, of graphics windows, 5-2
diamond symbol ($), 3-2
dir command, 4-7
directories, and FTP commands, 4-6, 4-7
“Disk Full Error” error message, A-3
Domain Name Resolver (DNR). See MacTCP Domain
Name Resolver (DNR)
Domain/Hostname...Realm option, 3-6



Domain/Hostname-to-Realm maps, 3-6
double-height characters, B-1
double-width characters, B-1

E
Edit menu
and controlling FTP access to your Macintosh,
4-4

copying in, 1-5, 5-4, 6-2
copying tables in, 1-5, 2-2
editing of configuration records in, 2-3
pasting in, 1-5
setting global preferences in, 2-1
setting macros in, 2-15
Edit%FTP Server command, 4-3
editing
local line editing, 2-7
of session configuration records, 2-3, 2-5 to 2-8
of set files, 2-15
of terminal configuration records, 2-3, 2-4 to
2-5
and VT escape keys, B-1
Eight bit connections option, 2-5
EMACS arrow keys option, 2-4, 3-1
EMACS arrow mapping command, 2-9, 3-1
EMACS editor, arrow keys in, 2-4, 2-9
Emulation option, 2-5
Encrypt option
in Open Connection dialog box, 1-2, 3-6 to 3-7
in Session Configuration Record dialog box,
2-7,3-6to 3-7
encryption, 1-2, 2-7, 3-5, 3-7 to 3-8, 4-5
END key, 2-5, 2-10
Erase Character command, 3-4
Erase Line command, 3-4
“Error deleting old file” error message, A-3
“Error in Sfwrite” error message, A-3
error messages
for fatal errors, A-2
for low level errors, 2-7
new system for, A-1 to A-2
for nonfatal errors, A-1
old-style, A-2 to A-3
regarding connections to a host, 2-2
for semifatal errors, A-2
ESCA (escape, caret), 6-2
ESCape character
in ICR programs, 6-5
macro for, 2-16
remapping of, 1-4, 2-1
escape codes, for VT200, B-1 to B-3
escape sequences, for ICR graphics, 6-1, 6-2

/etc/termcap file (UNIX systems), 2-11

Example button (for identifying file type and file
creator), 4-4

external configuration files, discontinued in Version
2.6, vi, 2-3

F

fatal errors, A-2
file creator type, 2-2, 4-4
File dialog box, 2-14, 2-15
File menu, 1-2
closing a connection to a host in, 1-5, 1-6, 2-2
displaying Kerberos tickets in, 3-6
enabling and disabling MacBinary files in, 4-9
ending (quitting) a session in, 1-6
establishing page setup in, 1-5
establishing printing selections in, 1-5, 5-4
loading saved set from, 2-15
opening a connection to a hostin, 1-2, 2-14, 4-2
saving sets in, 2-14
File Transfer Protocol (FTP)
configuring an FTP server, 4-3 to 4-4
controlling FTP access to your Macintosh, 4-4
to 4-5
definition of terms, 4-1
and NCSA Telnet, 4-1
transferring files via, 4-6 to 4-9
using an FTP client, 4-2 to 4-3
file transfer server (standard FTP), v
file transfers
definition of, 4-1
errors during, A-3
from a host to Macintosh, 4-7 to 4-8
of MacBinary files, 4-9
from Macintosh to a host, 4-8
of multiple files, 4-8
preparations for, 4-5 to 4-7
procedure for, 4-7 to 4-9
software for, v
file type, 2-2, 2-15, 4-4
files, saving sessions as, 2-13. See also ASCII files;
binary files
Finder, loading saved sets from, 2-15
Font% command, 2-12
Font options, 2-5
fonts
proportionally spaced, 2-12
setting from Session menu, 2-12
setting in terminal configuration record, 2-5
Forcesave option, 2-7
form feed command, to clear TEK images, 2-10
4014 and 4015 options, 2-6, 5-1
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FTP (File Transfer Protocol). See File Transfer Proto-
col (FTP)

FTP client, 1-2, 4-2 to 4-3

FTP client connection message, 4-2

FTP commands, 3-4, 4-6 to 4-7

FTP log, 4-3

FTP server, 4-3 to 4-4, 4-5, 4-6, A-3. See also anony-
mous FTP server

FTP Server Preferences dialog box, 4-3 to 4-4, 4-5

FTP Session option, 1-2, 4-2

FTP sessions, authentication and encryption of, 3-7

FTP Users Preferences dialog box, 4-4

function keys, B-3

get filename command, 4-7, 4-8
Global Preferences dialog box, 2-1
and copying tables, 1-5, 2-2
and file creator type, 2-2
options for, 2-1 to 2-2
and use of backquote () as ESC, 1-4, 2-1
graphics
Interactive Color Raster (ICR), 6-1 to 6-9
Tektronix, 5-2 to 5-4
graphics windows
copying, 5-4, 6-2
deleting, 5-3, 6-1
detaching, 5-2
pasting of, 6-2
printing, 5-4
resizing, 5-4
zooming and unzooming, 5-3 to 5-4
grave accent (")
as ESCape character, 1-4, 2-1
printing of, 2-1
grow icon, 5-4

Half duplex option, 2-7

hardware requirements, for running NCSA Telnet
for the Macintosh software, vi

help FTP command, 4-7

HES file system, A-2

HOME key, 2-5, 2-10

host, connections to. See connections to a host

“Host or gateway not responding” error message,
A-3

Hostname option, 2-6

Host/Session Name option, 1-2, 2-6, 3-2
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I-beam cursor, 4-6
icons
file icon, 4-6
grow icon, 5-4
NCSA Telnet application icon, 1-1
padlock icon, 3-7 to 3-8
for saved sets, 2-15
ICR commands, 6-2 to 6-4
ICR protocol. See Interactive Color Raster (ICR)
graphics
IETF draft AUTH_ENCRYPT option, 3-5
image files
definition of, 4-1
transferring files as, 4-7
IMCOMP compression scheme, 6-4
Inhibit option, 2-6, 2-10, 5-1
Interactive Color Raster (ICR) graphics
creating an ICR program, 6-2 to 6-6
sample ICR program in C, 6-6 to 6-9
using ICR protocol, 6-1 to 6-2
International Standards Organization (ISO) charac-
ter set, 4-4
Interrupt command, 2-7 to 2-8, 2-12
IP address
for FTP file transfers, 4-6
for host's domain name, 2-6, 3-2
for your workstation, 1-1, 2-16, 3-3, 3-4

J

Jump Scroll command, 2-10

KConfig, 3-5
Kdriver package for Kerberos (Cornell), 3-5
Kerberos Client extension, 3-5
Kerberos Configuration dialog box, 3-6
Kerberos tickets, 3-5, 3-6
Kerberos Version 4 software, 3-5
key mapping, for VT terminals, B-1
keyboard commands
*-" (grave accent), 2-1
* key (for remapping CONTROL key), 2-1
*-0 (for setting window size), 2-12
*-F (for Send FTP Command), 4-6
*-M (for defining macros), 2-15
*-N (for next session), 3-1
*-0 (for Open Connection command), 2-14
*-T (for Copy Table command), 2-2
keyboards. See Macintosh keyboard: Macintosh Plus
keyboard; VT terminals
keypad codes, B-2



L

LaserWriter printers, 5-4
line feed, emulating VT terminal, 1-4
Load Set command, 2-15
Local Echo command, in Session menu, 2-9
local echo mode, 2-7, 2-9
Local Echo option, in Session Configuration dialog
box, 2-7
local line editing, 2-7
Local Realm option, 3-6
logging on
to a host, 1-3
to a server, 4-2 to 4-3
Login button, 3-6
.login file, 2-12
login name, 1-1, 1-3, 4-2
Logout button, 3-6
Togout command, 1-4
logout procedures, 1-4 to 1-5
low level errors, 2-7

MacBinary Enabled command, 4-9
MacBinary files

definition of, 4-1

enabling and disabling, 4-9

resetting, 4-4

transferring, 4-9

use of, 4-4, 4-7
Macintosh clipboard

and copying graphics windows, 6-2

and copying tables, 2-2
Macintosh keyboard

CONTROL key on, 2-1

emulating VT keyboard, 1-4

remapping backquote to ESC on, 1-4, 2-1
Macintosh Plus keyboard

emulating VT keyboard, 1-4

remapping backquote to ESC on, 1-4, 2-1
Macintosh System Software User's Guide, 2-5, 2-13
Macintosh Version 6.0 system software, vi, A-2
Macintosh workstations

color screens at, 2-5, 2-13

file transfers to, 4-8

IP address of, 1-1

system requirements for, vi, A-2
Macro Configuration dialog box, 2-15 to 2-16
macros

(setting screen size), 2-12, 2-16

03 (CONTROL-C), 2-16

04 (CONTROL-D), 2-16

05 (CONTROL-E), 2-16

10 (for CONTROL-H OR BACKSPACE), 2-16
33 (ESCape), 2-16
for CONTROL-H (BACKSPACE), 2-16
definition of, 2-15 to 2-16
(for Internet address of current Mac), 2-16
keys assigned to, 2-15 to 2-16
reverting to previous, 2-16
saving, 2-16
(tabs), 2-16
MacTCP, vi, 3-4, A-2
MacTCP Domain Name Resolver (DNR), 2-6
magnification, of graphics windows, 5-3 to 5-4
Map PgUp, etc. option, in Terminal Configuration
Record dialog box, 2-5
Map PgUp/PgDown/Home/End command, in Ses-
sion menu, 2-10
memory
insufficient, 6-1, A-1
leaks plugged, vi
for raster graphics, 6-1
META CONTROL keystrokes, 2-5
META-anykey, 2-5
mget command, 4-8
Microsoft Excel, copying tables into, 1-5
Microsoft Word, copying tables into, 1-5
Monaco (font), 2-12
mouse
and EMACS arrow keys option, 2-4
positioning cursor with, 3-1
and resizing windows, 2-11
Multifinder, and memory, 6-1
multiple connections to a host, 1-2, 3-1 to 3-2
multiple file transfers, 4-9
multiple sessions, 2-13

NAWS (Negotiations About Window Size) option,
2-12
NCSA Contacts, inside title page
NCSA Orders, inside title page, C-2
NCSA software
via anonymous FTP server, C-1 to C-2
via archive server, C-2
via U.S. mail, C-2
NCSA Software Development Group (SDG), address
for, inside title page
NCSA TCP/IP drivers, discontinued, vi
NCSA Technical Resources Catalog, inside title page,
C-2
NCSA Telnet application icon, 1-1
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NCSA Telnet for the Macintosh software
Version 2.5
bugs fixed from, vi
discontinued features of, vi
Version 2.6
beginning a session, 1-1
changes from Version 2.5, v-vi
closing a connection to a host, 1-5, 1-6, 4-8,
6-1
configuration of, vi, 2-3 to 2-13
copying with, 1-5, 2-2, 5-4, 6-2
copyright, inside title page
customization of, 2-1 to 2-16
emulating VT terminal keyboard, 1-4, B-1
to B-3
ending (quitting) a session, 1-5, 1-6
error messages in, A-1 to A-3
features of, v
getting started in, 1-1 to 1-6
installation of, 1-1
internal FTP server in, 4-1
logging on to the host, 1-3
memory allocation, 6-1
new error message system in, A-1 to A-2
old-style error messages in, A-2 to A-3
opening a connection to a host, 1-2 to 1-3,
3-1
pasting with, 1-5, 2-2, 2-6, 6-2
printing with, 1-5, 5-4
resource missing from, A-3
setting BACKSPACE/DELETE key, 1-3, 2-7,
2-9
setting VT terminal type, 1-3 to 1-4
system requirements for, vi, A-2
Network menu
aborting output in, 3-4
description of, 3-3
erasing current line in, 3-4
erasing last character in, 3-4
identifying IP address of your Macintosh in, 3-4
interrupting process in, 2-7, 3-4
network-related commands on, 3-4 to 3-5
telnet commands on, 3-4
verifying connection to a host in, 3-4
networking
displaying IP address of your Macintosh dur-
ing, 3-5
software for, v
suspension of communications in, 3-4 to 3-5
New option, in Preferences dialog boxes, 2-3, 2-4,
2-6, 4-5
Next Session command, 3-1
bugs fixed, vi
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nonechoing mode, 2-7
nonfatal errors, A-1
Normal background box
in Terminal Configuration Record dialog box,
2-5
Normal background option
in Color Selection dialog box, 2-13
Normal foreground option, Terminal Configuration
Record dialog box, 2-5
Normal Text option, in Color Selection dialog box,
2-13
notational conventions, in the manual, vi-vii
number of print copies, 1-6
numeric keypad
Macintosh versus VT, 1-4
VT200, B-1

Off option (for FTP server mode), 4-3, 4-5

On, No passwords needed option, 4-3, 4-5

On, Username & Password required option, 4-3, 4-5

Open Connection... command, 1-2, 2-14, 4-2

Open Connection dialog box, 1-2, 2-3, 2-6, 3-2, 3-6 to
3-7,4-2

Open File dialog box, and file creator type, 2-2

OPTION key, 3-1, 5-2

orders for NCSA software, inside title page

P

padlock icon, 3-7 to 3-8
PAGE DOWN Kkey, 2-5, 2-10
page feed, in printing, 1-6
PAGE key (on Tektronix terminal), 2-10, 5-2
Page Setup command, 1-5
Page Setup dialog box, 1-5, 5-4
PAGE UP key, 2-5, 2-10
Password option, 4-5
passwords, 1-1, 1-3, 3-5, 3-6, 4-2, 4-3, 4-5, 4-6
Paste command, 1-5
Paste Method option, 2-6
pasting
in Edit menu, 1-5
of ICR graphics windows, 6-2
options for, 2-6
performance, Timeslice option for improving, 2-2
pixel data, 6-4
Please Select New Color heading, 2-13
Port option, 2-6
Preferences dialog box
for specifying terminals in configuration
records, 2-3, 2-4, 2-6



Preferences dialog boxes, 2-3, 4-3, 4-4

for specifying FTP servers, 4-5
Preferences file, vi, 4-5, A-2
Preferences menu, 4-3
Preferences%FTP Users command, 4-4
Preferences%Global command, 2-1
Preferences%Session command, 2-3
Preferences%Terminal command, 2-3
Print dialog box, 1-6
Print Selection command, 1-5, 5-4
printers

and graphics output, 5-4

selection of, 1-6
printing

of grave accent (), 2-2

procedure for, 1-5

of Tektronix graphics windows, 5-4
put filename command, 4-7 to 4-8
pwd command, 4-7

Quick option, 2-6

Quit command, 1-6, A-2

quote MACB DISABLE command, 4-9
quote MACB ENABLE command, 4-9

raster graphics. See Interactive Color Raster (ICR)
graphics

Reduce or Enlarge option, 5-4
Remap backquote to ESCape option, 1-4, 2-1
remote echo mode, 2-9
Remove option, in Preferences dialog boxes, 2-3, 4-4
Repair command, A-2
Reset Macbinary after each transfer option, 4-4
Reset Terminal option, 2-4, 2-10
resizing

of screen size, 2-11 to 2-12

of Tektronix graphics windows, 5-4
Resume command, 2-7 to 2-8, 2-12, 3-4
ROM, requirements for, A-2
run-length encoded (RLE) lines, 6-4, 6-5 to 6-6

Save button, in File dialog box, 2-14
Save cleared lines option, 2-5
Save File dialog box, 2-13
Save Set command, 2-14
saved sets
corruption of, A-1
macros saved in, 2-16
procedure for using, 2-13 to 2-15

saved-seticon, 2-15
Screen Colors option, 2-5
Screen Height option, 2-5, 2-11
Screen Width option, 2-5, 2-11
screens
clearing TEK images from, 2-10
clear-screen command sequence, 5-1, 5-2
saving cleared, 2-5
setting colors of, 2-5, 2-13
setting size for VT emulation, 2-5, 2-10 to
2-12,2-16
scrollback buffer
and jumping over scrolling text, 2-10
saving cleared screens in, 2-5, 2-10
saving screen with Forcesave option, 2-7
setting number of lines in, 2-5
setting PAGE UP, PAGE DOWN, HOME and END
keys in, 2-5, 2-9
Scrollback option, 2-5
Select Application button
in Global Preferences dialog box, 2-2
in Text Creator box, 4-4
Select Screen Dimensions dialog box, 2-11
semifatal errors, A-2
Send “Abort Output” command, 3-4
Send “Are You There?” command, 3-4
Send “Erase Character” command, 3-4
Send FTP Command command, 3-3 to 3-4, 4-6
Send “Interrupt Process” command, 2-7, 3-4
Send IP Number command, 2-16, 3-4, 4-6
Send“Erase Line” command, 3-4
serial connection, discontinued in Version 2.6, vi
Server IP address...Realm option, 3-6
Server Mode options, 4-3, 4-5
Session Configuration Record dialog box, 2-4, 2-6 to
2-8, 3-6 to 3-7, 5-1
session configuration records, 2-3, 2-5 to 2-8, 3-2
Session menu
commands in, 2-9 to 2-13
setting BACKSPACE/DELETE key in, 1-3, 2-9
setting up keys in, 3-4
Tektronix-related commands in, 5-2
sessions
active, 3-1, 3-2
beginning (starting), 1-1
changing configuration after connection, 2-9 to
2-13
ending (quitting), 1-5, 1-6
multiple, 2-13
names of, 1-2, 1-3, 2-6, 3-2
saving as files, 2-13
setting configuration record for, 2-5 to 2-8
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windows remain open after connections are
terminated, 2-2
Sessions menu, 2-9
Set Macros command, 2-15
Set Screen Size... command, 2-11 to 2-12, 2-16
sets. See saved sets
Setup Keys... command, 2-12, 3-4
Show Credentials command, 3-6
Show FTP log at startup option, 4-3
Show low level errors option, 2-7
Show Network Numbers command, 2-16, 3-4
Show Network Numbers dialog box, 3-5
size box, and resizing windows, 2-11
Size% command, 2-12 to 2-13
SLIP Connections, discontinued in Version 2.6, vi
software requirements for NCSA Telnet for the Mac-
intosh, vi, A-2
special characters, macros for, 2-15 to 2-16
Staggered Windows option, 2-2, 3-2
stty program (Berkeley UNIX-based systems), 2-12
Suspend command, 2-7 to 2-8, 2-12, 3-4
Suspend Network command, 3-4
symbols
+ (checkmark), 3-2, 4-9
$ (diamond), 3-2
~ (circle), 3-2
system requirements
for Interactive Color Raster (ICR) graphics, 6-1
for NCSA Telnet for the Macintosh software, vi,

A-2
T
tables, copying of, 1-5, 2-2
tabs

macro for, 2-16
resetting default of, 2-10
TEK end command, 5-1
TEK form feed clears screen command, 2-10, 5-2
TEK options, 2-6, 2-10, 5-1
TEK page clears screen option, 2-7
TEK Page... command, 2-10, 5-2
Tektronix 4014 or 4015 emulation, 2-6, 5-1 to 5-2
Tektronix emulation
and clear screen command, 2-7, 5-1
and form-feed command, 2-10
getting started in, 5-1
and manipulation of graphics, 5-2 to 5-4
options for, 2-6
and PAGE key, 2-10
termcap file (UNIX systems), 2-11
Terminal Configuration Record dialog box, 2-4 to
2-5
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terminal configuration records, 2-3, 2-4 to 2-5, 2-8
Terminal Name option, 2-4
Terminal option, 2-4, 2-6, 2-8
Text Creator option, 4-4
TEXT file type, 2-15. See also file type
text files. See ASCII files
tickets, in Kerberos, 3-5, 3-6
Timeslice option, 2-2
timing-mark flush, 2-8
timing-mark operation, 2-8
timing-mark processing, 2-8
titles
of icons, 2-4
of windows, 2-4, 3-2, 3-3
Translation% command, 2-10
“Translation resource is corrupted” error message,
A-3
Translation Table option, 2-8
typefaces. See fonts

UDP daytime server, 3-5
Underline option, 2-2
UNIX operating system
Berkeley version of (4.3 BSD), 2-7, 2-12, 4-6
and file transfers, 4-2
logout procedures, 1-5
and multiple file transfers, 4-8
online documentation for, 4-6
setting terminal types for, 1-4
termcabp file in, 2-11
unzooming, of graphics windows, 5-3 to 5-4
U.S. mail, NCSA software available via, C-1 to C-2
Use ISO Translation option, 4-4
Use Macbinary II option, 4-3
Use VT wrap mode option, 2-4, 2-9
Username option, 4-5
usernames, 4-3, 4-6

v

VAX/VMS, setting terminal types for, 1-4
Vertical Bar option, 2-2
vi editor
and cursor positioning with mouse, 3-1
and screen size, 2-12
VMS environments, full-screen, 2-7
VT terminals
in autowrap mode, 2-4, 2-9
compatibility with, B-1
editing key codes, B-1
escape codes for, B-1 to B-3
key mapping, B-1



W

resetting, 2-10, 5-2
word wrapping with, 2-4, 2-9
VT52,B-1
VT100
emulating keyboard of, 1-4, 2-5
setting terminal type, 1-3 to 1-4
termcap files default, 2-11
VT102
connecting to host as, 1-3
emulating keyboard of, 1-4
setting terminal type, 1-3 to 1-4
VT200, B-1
VT220
connecting to host as, 1-3
emulating keyboard of, 1-4, 2-5
setting terminal type, 1-3 to 1-4

warnings

about access to FTP server without password,
4-3

about closing connection while transferring
files, 4-7

about multiple file transfers, 4-9

about resizing windows, 2-11 to 2-12

about system color problems, 6-2

about trailing spaces, 6-5

insufficient memory for raster graphics, 6-1

warranty statement, inside title page
Watson, Rick, 3-5

wildcards, and file transfers, 4-1, 4-8
Window Name option, 1-2, 1-3, 3-2
windows

creation of, 6-3

destruction (removal) of, 6-3

of multiple sessions, 3-2

remaining open after connections are termi-
nated, 2-2

resizing, 2-11 to 2-12, 2-16

staggered viewing of, 2-2, 3-2

for Tektronix images, 2-7, 2-10, 5-2 to 5-4

titles of, 2-4, 3-2, 3-3

Windows don't go away option, vi, 2-2
word wrapping, with VT terminals, 2-4, 2-9
Wrap Mode command, 2-9

X

Xterm escape sequences, 2-4
Xterm sequences option, 2-4

z

zooming, of graphics windows, 5-3 to 5-4
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